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Schedule of Rates Overview

In a Schedule of Rates contract the contract consists of a rate for each Schedule Item of work to
be done. For each item there is an expected contract quantity. The sum of quantity by rate for
all the items gives the contract sum.

An Item is defined as a portion of the work required under the contract and is referred in the
Tender Schedule. Itis characterised by the following data:

Item no

Description

Unit of measure

Quantity (which can alter)
Agreed contract rate

Every item has a mandatory 6 digit sequence number, and this number is used to present items
in the sequence number order in screens and reports, including the Progress Claim. Sequence
numbers can be changed as required by the user. Sequence numbers from 990,000 to 999,999
are reserved for system use.

For Schedule of Rates contracts the Final Contract Sum is a function of the following:

e Forecast Final Quantity of work for each Item
e Variations

If the quantity of work finally done for an item exceeds, or is less than, the quantity specified in
the schedule of quantities, then the contract quantity for that item is adjusted, along with the
contract sum.

The major difference between a Schedule of Rates project and a Lump Sum project is that the
Contract Sum is built up from the quantities and rates in a Schedule of Rates project, and thus
there is no need to enter a Contract Sum and Margin in the Job Setup screen.

The dissection of the budget cost for each Schedule Item (Called Resources) is entered into
Jobpac on individually numbered lines. This may be the estimate itself or a summary of the
estimate or the Project Managers own dissection.

Each budget cost line (Resource) is associated with one Cost Centre. A Cost Centre can
consist of multiple lines from different Items or from the same Item. All Committed Costs and
Actual Costs are collected at the Cost Centre level not at the Item budget cost line level.

Preliminaries and overhead recovery can be managed in different ways in Schedule of Rates
projects. Sometimes preliminaries costs are included within the prices of each of the Schedule
Items, and sometimes preliminaries are separate items on the schedule.

If preliminaries and overheads are separate items in the schedule, then they are setup as
Schedule Items, and treated like any other item. If the preliminaries budget is embedded as a %
within each of the list of Schedule Items, then specific functionality exists to automatically
calculate this budget.

A specific menu item can be used to establish the business rules associated with this feature.

A % of the budget for each Schedule Item is defined, and as the budget for each item is entered
into the system, the percentage is used to calculate a prelims budget amount, and this budget is
accumulated in a single nominated holding cost centre.
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A normal set of preliminary and overhead cost centres should be setup for the project. These
will initially have no budget. These preliminary cost centres will be linked by one or more item
with no price. Using item maintenance and these preliminaries items, overheads can be setup
for each preliminary cost centre. The budget for each of these overheads comes from the
accumulated budget of the holding cost centre.

As item quantities change, this will automatically increase or reduce the overall preliminaries
budget. User can then spread this additional budget across cost centres as required.

A flag is provided at the item level to exclude items from this contribution to preliminaries budget
if required. A flag is also available at the sub item level to exclude that sub item from the
preliminaries budget contribution.

If the preliminaries budget is embedded as a % within each of the list of Schedule Items, then
parameters must be setup to define the business rules associated with the budget calculation.

The option to select a Job as a Schedule of Rates project is greyed out by default. To open up

this option, the parameter SORJOB must be set to Y.

The Resources mentioned above should not be confused with the Resource/Activity code facility
that can be used to cost projects. The two functions are completely different. With resources for

SOR projects these are referred to a Resource Names or Resource Descriptions.

S & Trimble. Construction
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Configuring a Schedule of Rates (SOR) Project

This section covers the Project specific configuration required to be able to setup Schedule of
Rates (SOR) jobs in Jobpac. SOR jobs can be entered manually into Jobpac or uploaded from
the Expert Estimation system (or from any other estimating system, if it can generate the Expert
upload format).

The detail of configuration for SOR project is described in this section. For experienced users
the following quick checklist can be used.

Ensure an appropriate template job is setup.

Setup the new SOR project using Job setup.

Setup any required cost centres for overhead budget management defaults
Ensure Forecasting Method table is setup.

Setup any required sections for overhead management and variations
Setup the SOR Parameter

Upload the project from Expert Estimation format in preview mode.

Fix any errors in upload

Upload the project.

Template Project

A template project is required to load an estimate from Expert Estimation template into Jobpac.
The Template Job defines the cost centres that are permitted on the project.

During the upload process the Cost Centres used in the upload file are validated against the
Template job and when the cost centre has not been created prior to the upload the description
in the template job is used to create the cost centre.

Cost centres may be created prior to the upload from the menu option “Set up Cost Centres”.
This will be necessary for some system required cost centres.

Setting up a Project

The key reference for setup and maintenance of Project is the Job Setup and Maintenance
module guide. This manual will describe the standard data that can be recorded for all project
types in Jobpac. This section will cover the specific steps required to setup a Schedule of Rates
project.

A schedule of rates project requires parameters to be setup in Job Maintenance. This
documentation will cover just those settings required for schedule of rates projects.

Select Projects>Job Setup and Reports>Setup Jobs.
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Job Maintenance : Type

Mode MODIFY

Jab SORPRO Schedule OFf Rates Project

TYPE SETTINGS WVALUES SCHEDULE NSURANCE CLIENT STAFF

Payroll Interface Parameters

Allowance Allocation Method O Employee by Employee O JobbyJob @ No Allocation Method

Item Maintenance Parameters

O This a property development job

This a schedule of rates head contract

Earned Budget Facility/ltem Structure Used

O Use Cost Code Sub Items

Earned Budget/Item Structure @& Use Separate Item Structure

Earned Budget Forecasting O Use Budget Items & Subitems & Use PMW - Create PMW Entries

) Use PMW - Do Mot Create PMW Entries () Maone

GUARANTEES

DEFINED FIELDS

O Use Cost Centres Only

ACTIONS

Other Parameters

O This a Small Orders Job

[0 Use Cost Centre Security

[ Thisisatemplate job

Project Managers Worksheet Formula

Nominate GL at CC Level OR Service Order

[ Is this a Cost Plus Billing Job?

O Use Resource Code Cost Trackin

[ Use Resource Library Forecast Control

OA OB OC OD OE OG @H OL O None

O AtCClevel @ MNotat CClevel O Service Order

If Yes, Enter Markup Percentage

g7 [ Disable Excel In Progress Claim Terms & Conditions Format

Template Job Number

SORTMP £ SO0R Template

Field

This a Schedule of
Rates head
contract

Earned Budget
Facility Used

Earned
Budget/Item
Structure

Earned Budget
Forecasting

Project Managers
Worksheet
Formula

Use Forecasting
by Input of
Forecast Rate to
Complete

Page 9 of 87
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Description

Set to Y. This must be done before ANY activity occurs on the project. It is not
possible to change this from N to Y after any budgets have been setup on the
project.

Set this to Y. Even if you are not using Earned budget reporting, this will give
you the option to use it later in the project if required.

Should be set to Separate item structure. Other options not applicable to SOR
projects.

Recommended option is PMW- Create PMW entries. This will keep Project
Managers Worksheet (Forecasting entries) synchronised with sub item details
(known as resource names or descriptions )

This must be set to H. This means the system uses Cost of Work in Progress as
the starting point to forecast cost to complete for Schedule Items, and cost
centres.

Optional — Set to Y to enable the input of the Forecast Rate to complete for a
whole Schedule Item on the Project managers Worksheet Forecasting by Item
screen. This overrides forecasting done at the Schedule Item Resource Name
level. Two options exist for this function. The default is to update each resource
rate proportionally with the change in FFC Rate. The other option is for the
system to calculate the overall change in forecast for the Schedule Item, and to
assign this change to the nominated cost centre.
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Field Description

Thisis atemplate Setto Y to use the Cost Centre structure of this job as a template for other jobs.
job When set to Y a template job number cannot be entered for this job. This should
be set to N for a schedule of Rates project.

Template Job When using Expert Estimation template to create a Schedule Item structure,

Number enter a template job number which will be used to validate cost centres during
the import process. Any cost centres created later in the project must be
present in this template job.

Use Resource This is only set to Y if the resource library is to be used. If the resource library is
Library Forecast used, resources are called Resource Names, and if it is not used resources are
Control called Resource Descriptions

Note: In the Values Tab, no contract amounts or margins are entered as these are
automatically calculated when Schedule Item prices and budgets are entered via ltem
Maintenance or by Upload of the Schedule.

Cost Centres/Codes

Select Projects>Job Setup and Reports>Setup Cost Centres.

Budgets for SOR projects are not setup using Cost Centre maintenance, these are
automatically calculated when budgets for each Schedule Item are entered in Item maintenance
or when the Schedule is uploaded. However, the cost centres themselves must be setup using
this screen if the project is being setup manually. To setup cost centres manually for SOR
projects, select the Fast Entry option.

Cost Code Maintenance & actions | & ok BACK
Refresh
Job  SORPRO Schedule Of Rates Project
Fa%rm’
Unalloc Budget Alloc Budget Budget Not Finalised
MNext Tab
BUDGET GL ACCOUNT LINK TIME PHASED PLANNING Job Enguiry
Y Hide  Apply  Clear Copy £ »  eee
Clear Filters
jol jol
— Download _—— —
o o Upload
Cost Code T Description H/h/ifj Budget Quantity Unit Rate Group Scp Sts PMIER

Cost Centres can be added after the last entry. Use ‘New Cost code’ in the Actions Menu

Providing cost centres do not have budgets, they can be deleted from the screen below by
replacing the X with a C and either press ENTER or click OK to update your changes. Multiple
cost centres can be deleted at one time.

& Trimble. Construction
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Cost Code Maintenance & actions @& ok
Job SORPRO Schedule Of Rates Project
Y Hide  Apply s £

Cost Type (x To Select Or C To Cancel)

Cost Code Description Heading LB MT SC PL ot RV
Code (H/h)

1013 Recruitment X X X X

1020 Labour (Warkcover Lost Time) X

1021 Labour (Warkcover Restricted W X

1555 Disputed Payments h

1555 Disputed Payments X X X X

1999 Buying Gain X X X X

2000 EARTHWORKS & ROADWORKS H

2010 Clearing, Grubbing, Demoliti h

2010 Clearing, Grubbing, Demolition X X X

2020 Topsoil Stripping h

2020 Topsoil Stripping X X

2030 Earthworks h

2030 Earthworks X X X

Note: When the Expert Estimator template upload is used and cost centres have not been
defined the cost centres will be created during the upload process using descriptions from
the template job nominated on the Job Maintenance “Type” TAB.

Schedule Sections

If the schedule of rates is broken into defined sections, then these sections can be setup. Once
setup, every item in the schedule may be associated with a section.

There are three sections that have a specific meaning

e Section to contain all overhead items that source their budget from a component of the
Schedule Item schedule.

e Section to contain all variation overhead items that source their budget from a
component of the variation Schedule Item schedule

e Section to contain all variation Schedule Items

These will be explained in the setup of the SOR parameter for the project.
Select Projects>Job Setup and Reports>Schedule of Rates>Setup Schedule Sections.

When the Setup Schedule Sections is selected from the menu a job selection screen is
displayed. Selecting the job displays the following screen.

& Trimble. Construction
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Trades/Sections Maintenance & actions @& ok
Job  SORPRO Schedule Of Rates Project
Y Hide  Apply ﬂ- <

Code Description
8000 Variations Section
9000 Prelims Section

9500 Variation Prelims Section

The three Sections above should be set for all projects, and then others added to break up the
Schedule. They are used in the Progress Claim.

Enter each section code and description directly into the table format. Use the option Add New
Code to position cursor for the new entry of a Section. If a section needs to be deleted, select
the Delete option from the right mouse click options.

If a longer description is required, select the Text option from the right mouse click options. The
Expand/Contract option can be used to display the full description of all sections.

The fields at the top of the table are for filtering entries already in the table.

ltem Types

Item Types are codes that can be setup to assign to Schedule Items to allow specific filtering.
These codes are NOT project specific, and apply to all projects within a workid. There are some
specific Item Types that are used by the system.

PS — Provisional Sum Schedule Item.
Automatically created by the Expert Estimation template upload if there are provisional sums
within the upload.

RO — Rates only Schedule Item.
Automatically created by the Expert Estimation template upload if there are rates only Schedule
Items within the upload.

RI — Rounding Item.
Parent/Child Schedule Items within the schedule may require a rounding item to ensure that the
Parent Item is the sum of child items. These are automatically created by the upload process.

Other Types can be created, but must be used consistently across the workid.

Select Project>Job Setup and Reports>Schedule of Rates>SOR Configuration>ltem Type
Maintenance.

The following screen will be displayed:
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Item Type Maintenance & actions @& ok
Y Hide  Apply Q <«

Type Description

Rl Rounding Child Pay Item

PS Provisional Sum

RO Rates Only

Iltem Type Maintenance

On this screen you can change the description of the item type by editing the field and either
press ENTER or click OK to update your changes.

To add a new item type click Add New Type on the Actions menu. This will position the user to
enter the code and the description.

To delete an existing item type, select Delete from the right mouse click menu.

Tagging Codes

Tagging Codes are user defined two character codes which are project specific and are
associated with Schedule Items. These codes provide no business rule logic but provide filtering
capabilities to assist in the maintenance and review of the Item / Sub Item structure. Project
Managers can use them as they choose to classify Schedule Items. Up to three codes can be
associated with a Schedule Item. Filtering facilities exist on many screens for the codes.

Select Project>Job Setup and Reports>Schedule of Rates>SOR Configuration>Tagging
Code Maintenance.

Item Tagging Codes Maintenance & actions @ ok

Job  SORPRO Schedule Of Rates Project

Y Hide  Apply 'a' <

Tagging Code Description
| Site Engineer 1
s2 Site Engineer 2

HR High Risk Item

Tagging codes can be associated with Schedule Items in the Item Maintenance screens.

=

]
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Forecasting Method

General Explanation

It is mandatory that every Schedule Item in a Schedule of Rates project is associated with a
forecasting method. This code will determine the relationship between the contracted quantity
and the forecast final quantity for the Schedule Item. These codes are “Hard Coded” and
cannot be changed, or new forecasting methods created.

These are setup using the following menu path. Only the descriptions can be changed.

Select >Job Setup and Reports>Schedule of Rates>SOR Configuration
>Forecasting Method.

These apply to all projects in a Workid, they are not project specific. All six must exist.

Forecasting Method Maintenance & actions @& ok
Y Hide  Apply ‘-'} 4
e
o]
Forecasting Method Description
cM Comment
LS Lump Sum
PI Parent Items
RO Rates Only
SC Schedule Iltem coupled
Su Scheduled Item Uncouplad

Business Rules

There are very specific business rules associated with these forecasting methods. These are
described in the Item Maintenance section of this manual.

Standard Forecasting Methods

The available Forecasting Methods are outlined below. Additional methods are not supported
without an enhancement to the base product.

Method Description

SC - Schedule Schedule of rates items where the Forecast Final Quantity (FFQ) is

Item Coupled automatically kept by the system to be the same as the Current Contract
Quantity, and vice versa.

SU - Schedule Schedule of rates items where the Current Contract Quantity is managed
Iltem Uncoupled separately from the Forecast Final Quantity (FFQ). i.e. changes to the
FFQ will not change the Current Contract Quantity, and vice versa.

LS —Lump Sum  Schedule Items declared as a Lump Sum. The Current Contract Quantity
ltem is frozen at Budget finalisation time, and the user maintains the Forecast
Final Quantity separately.
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Method Description

CM -Comment  These are comment lines only, and have no impact on Contract Value or
Iltem budget. Quantities or rates can be maintained against this type of item,
but have no impact on contract.

RO - Rates Only These Schedule of Rates items will have a rate and may have a quantity
and price, and have sub items to support the budget for the item. These
items will NOT update the contract values, budgets, or margins, and are
excluded from forecasting and may not appear on client schedules.

Schedule of Rates Parameter for Preliminaries Management
Description

Preliminaries recovery can be managed in different ways in Schedule of Rates projects.
Sometimes preliminaries cost is included within the prices of each of the Schedule Items, and
sometimes preliminaries are separate items on the schedule.

If preliminaries are separate items in the schedule, then they are setup as Schedule Items, and
treated like any other item. If preliminaries budget is embedded as a % within each of the list of
Schedule Items, then specific functionality exists to automatically calculate this budget.

A Schedule of Rates Parameter can be used to establish the business rules associated with this
feature. This parameter is mandatory if overheads are contained within the Schedule Item rates,
but does not have to be used if overheads are directly claimed from the client.

A % of the budget for each Schedule Item is defined, and as the budget for each item is entered
(‘or loaded from Expert Estimation template) into the system, the percentage is used to
calculate a prelims budget amount, and this budget is accumulated a single nominated holding
cost centre.

A normal set of preliminary cost centres should be setup for the project. These will initially have
no budget. These preliminary cost centres will be linked by a number of prelims items with no
budget and no price. All of these items will be setup with a defined Preliminaries Section defined
in the parameter. Using item maintenance and these preliminaries items, sub items (resources)
can be setup and related to preliminary cost centres. The budget for each of these items comes
from the accumulated budget of the holding cost centre.

As Schedule Item quantities change, this will automatically increase or reduce the overall
preliminaries budget. A user can then spread this additional budget across cost centres as
required.

A flag is provided at the item level to exclude items from this contribution to the preliminaries
budget if required. A flag is also available at the sub item level to exclude the selected sub item
from the preliminaries budget contribution.

Setup SOR Parameter

To setup the SOR parameter use the following menu option

Projects>Job Setup and Reports>Schedule of Rates>SOR Job Setup>Set SOR
Parameter.
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Schedule Of Rates Parameter Maintenance & actions @& ok BACK

TEMS VARIATIONS VARIATION SECTION

¥ Hide  Apply 9 < > vee
200 o o
200 o
Wkid  Job Description Use 1 Pl Seq PI Preliminary Pl PICost PI Def% FixPre  U/O Ui
Item # Sect Item Line Code T Bud Spread  Recowvry ReER
Prelim Calc Method Cost Code a
920 SOR SOR Project N 9999...

To add a new parameter for a project, select Add option. The following screen displays

Schedule Of Rates Paramater Maintenance & actions @& ok BACK

Work Id 2 O

Job Number  SQORPRO £ Schedule Of Rates Project

Items -
O Use One Item For Preliminaries Preliminary Sequence No. 999959
Preliminary Section Code 2000 D Prelims Section
Preliminary Item Code HOLDINGCP
Preliminary Sub-ltem Line N 99990
Preliminary Holding Cost Centre 9996 MT D
Default % for Budget Calculation 10.00

Fixed Prelims Under/Over Recovery - Spread Method (O Allow spread by function key and No manual spread
® Allow spread by function key and allow manual spread

O No function key available, only manual spread

Fixed Prelims Under/Over Recovery - Cost Centre 9997 MT D
Variations -

Variation Section o]

[0 Use One Item For Variation Preliminarie¥ariation Sequence No. 999998

Variation Preliminary Item Section Code 9500 o]

Variation Preliminary Item Code HOLDINGVYP
Variation Preliminary Sub-Iltem Line ! 09999
Variation Holding Cost Centre 9995 MT D

Default % for Variation Budget Calculation 19

Fixed Prelims Under/Over Recovery - Spread Method (O Allow spread by function key and No manual spread
® Allow spread by function key and allow manual spread
O No function key available, only manual spread

Fixed Prelims Under/Over Recovery - Cost Centre 9999 MT] D

If the project will be claiming preliminaries and overheads as part of the Claim Schedule, then

only, the Workid, Job No and Variation Section field need to be entered.

Field Description

Use one item for This is ticked if only one item is to be used for all preliminary budgets.
Preliminaries This is a carryover feature from release 7, and should not be used in RS,
i.e. remain unticked.
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Field

Preliminary
Section code.

Preliminary Iltem
Code

Preliminary sub
item Line No.

Preliminary
Holding Cost
Centre

Default % for
Budget
Calculation

Fixed Prelims
Under/Over
Recovery
spread Method.

Description

This defines the Section of the project that will hold all of Preliminary
items, including the nominated Preliminary Item Code which is used to
hold the overhead budget made available via a component of each
Schedule Item. Recommend that 9000 be used.

This defines the Item code which is used to hold the overhead budget
made available via a component of each Schedule Item. Each Item must
have a sequence number, and a system defined no of 999,999 is used
for the Item. Suggest HOLDINGCP (holding contract prelims)

Within each Schedule Item in the schedule, a sub item is automatically
created to hold the overhead contribution of that Schedule Item. This field
defines the line number that is used. It is usually set to 99,999 (the max
number).

This cost centre will hold budget that relates to the difference between
the overhead budget provided from contributions from the Schedule
Items, and the budget used for overhead items. This cost centre should
not be used elsewhere on the project. Recommend 9996/M. Make sure
this is setup in the Template project.

This is the default % of the total direct cost budget for a Schedule Item
that goes to the “pool” of budget for overheads. This will be defaulted
each time a new Schedule Item is created, but can be changed for that
Schedule Item as required.

When additional budget is made available via a remeasure of the
schedule, the user has options as how to spread this additional budget to
existing overhead budgets:

¢ Allow spread by function key and no manual spread.
Assigning this default option means the Actions option is used to
automatically spread the additional budget to existing sub items in
the prelims items, in the ratio of the current budget. No manual
changes can be made to these budgets.

e Allow spread by function key and allow manual spread.
Assigning this default option means the Actions option is used to
automatically spread the additional budget to existing sub items in
the prelims items, in the ratio of the current budget, or the spread
can be made by manual changes to these budgets.

¢ No function Key available, only manual spread

No automatic spread option available. The additional budget can
only be spread manually.
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Field

Fixed Prelims
Under/Over
Recovery — Cost
Centre

Variation
section

Use one item for
Variation
Preliminaries.

Variation
Preliminary Item
Section code.

Variation
Preliminary Item
Code.

Variation
Preliminary Sub
item Line No.

Variation
Holding Cost
Centre

Default % for
Variation Budget
Calculation

Description

Individual overhead budget sub items can be marked to not receive any
additional budget that may be made available. If the automatic spread
method is used, the amount of the budget that would be allocated to
those sub items marked to not receive additional budget, is placed in this
nominated cost centre. This budget can be used as contingency or as a
gain for the project. Recommend 9997/MT

The section that all variation Schedule Items are allocated to. This is the
way the system determines the Schedule Item is part of a variation, and
to apply the associated business rules for variation Schedule Items.
Recommend 8000. This must be setup for all SOR projects.

This is ticked if only one item is to be used for all preliminary variation
budgets. This is a carryover feature from release 7, and should not be
used in R8, i.e. remain unticked.

This defines the Section of the project that will hold all of the Variation
Preliminary items, including the nominated Variation Preliminary Item
Code which is used to hold the overhead budget made available via a
component of each Variation Schedule Item. Recommend 9500

This defines the Item code which is used to hold the Variation overhead
budget made available via a component of each Variation Schedule Item.
Each Item must have a sequence number, and a system defined no of
999,998 is used for the Item. Recommend HOLDINGVP. (holding
Variation prelims)

Within each Variation Schedule Item in the schedule, a sub item is
automatically created to hold the overhead contribution of that Variation
Schedule Item. This field defines the line number that is used. It is
usually set to 99,999 (the max number).

This cost centre will hold budget that relates to the difference between
the Variation overhead budget provided from contributions from the
Schedule Items, and the budget used for Variation overhead items. This
cost centre should not be used elsewhere on the project. Recommend
9998/MT

This is the default % of the total direct Variation cost budget for a
Variation Schedule Item that goes to the “pool” of budget for Variation
overheads. This will be defaulted each time a new Variation Schedule
Item is created, but can be changed for that Schedule Item as required.
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Field Description
Fixed Prelims When additional budget is made available via a remeasure of the
Under/Over Variation Schedule Items, the user has options as how to spread this
Recovery additional budget to existing Variation overhead budgets:

spread Method. _
e Allow spread by function key and no manual spread.

Assigning this default option means the Actions menu panel
option is used to automatically spread the additional Variation
budget to existing sub items in the Variation prelims items, in the
ratio of the current budget. No manual changes can be made to
these budgets.

¢ Allow spread by function key and allow manual spread
Assigning this default option means the Actions menu panel
option is used to automatically spread the additional Variation
budget to existing sub items in the Variation prelims items, in the
ratio of the current budget, or the spread can be made by manual
changes to these budgets.

¢ No function Key available, only manual spread
No automatic spread option available. The additional Variation
budget can only be spread manually.

Fixed Prelims Individual Variation overhead budget sub items can be marked to not
Under/Over receive any additional Variation budget that may be made available. If
Recovery — Cost the automatic spread method is used, the amount of the budget that
Centre would be allocated to those sub items marked to not receive additional

budget, is placed in this nominated cost centre. This budget can be used
as contingency or as a gain for the project. Recommend 9999/MT

Parent ltems
Description

The option exists within the SOR module to establish Parent Schedule Items, which are made
up of the sum of a number of Schedule Items, called child items. Parent Schedule Items are
those usually presented to the client on Progress Claims, and in the original schedule. Using
Child items allows more detailed management of budgets, earned values and forecasts on a
monthly basis.

Parent Iltems can be established either manually, or created via an upload from Expert
Estimation.

Manual Creation

A Parent code is first established. This code is the link between the Parent and the Child items.
This will automatically create the Parent Item in the Schedule. The Parent Item has a quantity
and a unit of measure, but no rate or Pay amount. The pay amount is derived from the sum of
the pay amounts from the Child items. The rate is calculated by dividing the sum of the child pay
amounts by the Parent quantity.

Automatic creation from Expert Estimation Template

Parent and Child Schedule Items can exist within the estimate produced by Expert Estimation.
These are loaded into Jobpac via the upload process. The value held as the Parent Pay amount
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becomes the Schedule Item schedule amount, and the child items are loaded as they appear in
the estimate. If any rounding difference between the sum of the children pay amounts, and the
parent pay amount occurs, then a rounding item is automatically created for that difference.
These rounding items have a sequence number in the protected range (>990,000), and are
given an Item Type of RI. This enables filtering to see these items. In Item maintenance and
Progress claim entry, these rounding items, and child pay amounts are, by default, not
displayed. On option exists to display in both these function to display the child items. More
information is provided in the description of these functions.

To set-up or maintain a Parent Code and Item from the Jobpac main menu,

Projects>Job Setup and Reports>Schedule of Rates>SOR Job Setup>Parent Item
Maintenance

A list of existing Parent Items is displayed. This is in expanded description mode. Each Parent
item within the project is uniquely defined by the two character code in the first column.

Parent Code Maintenance & actions @& ok BACK
Job 9088 SOR Demo Project
Y side  Apply D < > e
LI o] o o
Lhay o] o o
Code Sect Item Description Quantity UOM Insert After Seq No. Rate AmounB
AA T07 () On leads to roads and 3,573.0000 m 16.5000 58,954.50

allotments (bank volume)

AB 755 (b) Excess cut to fill from 19,768.0000 m 16.3200 322,613.76
Stage 1R1to 1A (bank volume)

AC 9509 (a) On leads to roads and 28,041.0000 m 142800 400,425.48
allotments (bank volume)

AD 9553 (d) Cut to fill sourced from 35,832.0000 m 16.8500 603,769.20

other stages (1R2 and 1R3)

On this screen you can update the details of the parent code by editing the fields and click OK
to update your changes.

To add a new parent code click Add New Code on the Actions menu, then enter the following
across the screen:

Field Description

Code Enter a 2 character code which is used to link the Parent Item and
child items (Mandatory). This uniquely defines the parent Iltem.

Section Enter section code required(optional)

Item Enter the Parent Item No required. (Optional, may be blank). This will
appear on the Progress Claim.

Description Enter the description of the Parent Item No.

Quantity Enter the quantity of the Parent Item

UOM Enter the Unit of Measure for this item.
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Field Description

Inset after Seq Controls the insertion point into the Item schedule for the Parent Item.

No. Use whatever sequence number you want.

Rate This field is a system calculated from the child items and not available
for input.

Amount This field is a system calculated from the child items and not available
for input.

To delete an existing parent code, select Delete from the right mouse click menu. They can only
be deleted if they are not linked to child items

Entering Long Description

There are many places within this software that extended text can be maintained. For example,
Description of a Schedule Item, Notes associated with resources, Subcontract Item
Descriptions, Variation item Descriptions.

In places where this is possible, Jobpac will automatically popup a text box in which to type
additional description. These are options within this popup box to save the entered description,
or clear the description in order to replace the description. User will be asked to confirm any
clearing of text. If no replacement text is entered, the first line of the cleared text will be inserted.
This is done to ensure blank descriptions are not left in the system.
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Setting up the Schedule of Items

[tem Maintenance

Schedule Items can be established either manually, or created via an upload from Expert
Estimation template.

ltem maintenance is used to

e Setup a new item

e Change or delete an existing Schedule Item.

e Combine items (Parent/child items) for the purposes of simplifying the progress claim.
User can flag a number of items that are to be combined with a specific code.

o Group Schedule Items via a user defined tagging codes. The code can be associated
with each item i.e. tag Schedule Items that relate to a particular foreman/leading hand
to allow filtering during the forecasting process to allow quick review of items directly
with the person.

Item maintenance has the following screen features

Delete all items

Delete a single item

Microsoft type shift delete to delete a group of items

Microsoft type control delete to delete a selection of lines

The Text option to display the full description will be displayed as a popup window with a

word wrap.

¢ If more description text exists in the system than is displayed on the screen, the
description will appear in different colour.

e Copy, Paste and Insert Option. These will be presented via a Right Mouse click options.
A range of items can be selected using Select and Shift key. When a paste or move is
undertaken, system will calculate the band of sequence numbers required at the
insertion point and re sequence the following sequence numbers accordingly.

e Filters exist in all screens. Any filter used in one screen also applies when other screens

are viewed. Single filter fields are either “Positioners” or text string filters e.qg. for

sequence number it would be a positioned and for a description, it would be a text
search through the descriptions.

The initial view will display the item no, description, contract quantity, sell rate and price. Items
will appear in sequence no. order even though the sequence no is not displayed on some
screens. Alternate views of Item maintenance screens will be provided to display section code,
sequence no and other appropriate values.

To set-up or maintain an ltem Code from the Jobpac main menu,

Select Project>Job Setup and Reports>Schedule of Rates>ltem Maintenance
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Item Maintenance & actions @& ok BACK
Job 9088 SOR Demo Project

Direct Cost Budget 9,883,100.21 Budget Finalised Y

Overhead Budget 210,374.27 Contract Sum 12,£77,299.52

Allocated 210,374.27 Budget 10,093,474.61

Available Margin 2,383,8269

SCHEDULE SEQUENCE NO. DESCRIPTION BUDGET QUANTITIES MARGIN OVERHEAD TAGS

¥ Hide  Apply > e

| o L O O PO - O p

Period FEB22

Item Description Hd Tp FM Par Quantity UOM Budget Rate Current Budget Tagl Tag2 Tag
2,09 Linemarking M
(a) General LS 1.0000  Item 5,488.8700 5,488.87
(b) Median islands with LS 1.0000  Item 9921800 99218
cm
an Concrete bin bays cm
cm
212 Supply and erect street name cm
(a) Posts LS 2.0000 No 259.6450 519.29
(b) Road name plates LS 40000 Mo 2171675 868.67
cm
213 Supply and erect signs cm
& Y e

Maintaining an Existing Item

The fields that can be modified will be white and the fields that cannot be changed will be
greyed out.

Field Description

Item Enter item code description.
Description

Sequence No. Can only be changed to an unused sequence no. User can only
nominate numbers from 1 to 899999. Sequence numbers from 990000 to
999999 are reserved numbers. Changing the item sequence no. will
change the position of item.

Heading Heading can only be changed to a comment item and only comment item
can be changed to heading. To change a heading to a comment item,
clear the heading and enter “CM” on the forecasting method column.

ltem Type Enter a valid item type or use the search function to select from Item
Type Scan. Item type is optional but if changed, should be to a valid
code.

Forecasting This field may be changeable. The following business rules control
Method whether the field can be changed, the types of changes allowed and the
impact on other item values:
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Field Description

When a LS item is changed to a SC item, then Forecast Final Quantity
will be changed to equal Current Contract Quantity, and Quantity To Go
will be recalculated by Qty to Go = Forecast Final Qty — Qty Done, and
Forecasting Worksheet Entries will be recalculated.

When a SC item is changed to a LS item, then no changes are made
to any item quantities.

When a LS item is changed to a SU item, then no changes are made
to any item quantities.

When a SU item is changed to a LS item, then no changes are made
to any item quantities.

When a SC item is changed to a SU item, then no changes are made
to any item quantities.

When a SU item is changed to a SC item, then Forecast Final Quantity
will be changed to equal Current Contract Quantity, and Quantity To Go
will be recalculated by Qty to Go = Forecast Final Qty — Qty Done, and
Forecasting Worksheet Entries will be recalculated.

When a RO item is changed to a SC, SU, or LS item, then the item is
treated as if a new item was added to the project. The contract sum,
margin and budgets are updated using the rates and quantities from the
RO item. The PMW will be populated.

Only a SC item can be changed back to a RO item, and only if no
claims have occurred for that item. This change will reduce the contract
sum, reduce the budgets, and remove entries from the PMW.

For SU items, Forecast Final Quantity will be separately maintained from
Current Contract quantity, however, if the Current Contract Quantity is
changed, the Forecast Final Quantity will be changed by the same
change in the Current Contract Quantity, e.g. If the Current Contract
Quantity is changed from 10 to 15, then Forecast Final Quantity will be
increased by 5. if Forecast Final Quantity is changed, Current Contract
Quantity will not change.

CM items can be changed to heading. They cannot be changed to SC,
SU, LS, or RO. Likewise, SC, SU, RO, LS or PI cannot be changed to a
CM items. To change comment line to heading, clear forecasting method
and enter either “H” or “h” on the heading column.

Pl items cannot be changed to any of the above forecasting method and
vice versa. Parent Item cannot be created via this program.

Parent Code  Enter the Parent Item code defined in Parent ltem Maintenance to link
this item to a Parent Item. When a child item is linked or unlinked to a
Parent Item, the Parent Item rate and sell price will also change. Parent
Item sell price is the sum of sell rate of the child items.
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Field

Forecast
Final Quantity
impact on forecasting.

UOM Enter Unit of Measure
Sell Rate

Parent Item sell price will also change.
Sell Price

Parent Item sell price will also change.

Exclude from
Claim

Item

Completed price.

Contribute to
Prelim

. % will be set to 0.
Prelim

Contribution
%
impact on the overhead budget.

Tagging
Codes

The Actions Button has the following options

Description

Enter “Y” to exclude the item from the Claim process.

When Forecast final quantity of SC item is changed, the current contract

guantity will also change. Changing forecast final quantity will have an

Changing sell rate will change sell price. If item is a child item, then

Changing sell price will change quantity. If item is a child item, then

Enter “Y” to lock the item and prevent updates to budget and sell rates /

If job is not managing preliminaries, then these two fields cannot be
changed. If flag was changed from Y to N, then prelim overhead budget

If flag was changed from N to Y and % was not entered, then % will be
set to the default %. Any changes on these two fields will have an

Tagging codes are optional and can be assigned as required by the
Project Manager. They are used to enable the filtering of Schedule Items.

Item Maintenance (v ACT'ONS & ok
Add New Item
Job 9088 SOR Demo Project
MNext Tab
Direct Cost Budget 9,883,100.21 Budget Finalised Y| ,
Expand/Contract
Overhead Budget 210,374.27 Contract Sum 1
Prompt
Allocated 210,374.27 Budget 1 Refresh
Available Margin 2 Toggle Price/Budget
SCHEDULE SEQUENCE NO. DESCRIPTION BUDGET QUANTITIES MARGIN OVERHEAD  TAGS Clear Filters
. Variation Section
Y Hide  Apply
Transfer Section
fo] fo] fo] fo] fo] Copy Single Item
Period  FEB22 Bulk Transfer Section
Bulk Item Copy
Item Description Hd Tp FM Par Quantity UOM Budget Rate
Chd Show/ Hide Child
2.09 Linemarking cm Spread OH Budget
(a) General Ls 1.0000  Item 5,488.8700 5,488.87
(b} Median islands with LS 1.0000  Item 9921800 992,18

BACK

Adding a New Item

From the Item Maintenance screen, to add a new Item, select New ltem from the Actions

Menu. The following screen will be displayed.

[
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Item Maintenance - Add

Job 2088
Sequence No.

Section

Item Number

Description

SOR Demo Project

& actions @& ok BACK

Heading

Item Type

Forecasting Method |5 D

Parent Code o]
Quantity

Unit of Measure

Sell Rate

Sell Price

Tag Codes 1,2,3 D o] o
O Exclude from Claim
O Item Completed
Contribute Prelim Budget
Prelim Contribution %
Field Description

Sequence No

Section

Item Number

Description

Heading
Item Type

Forecasting
Method

Parent Code

Quantity

Unit Of
Measure

Sell Rate

Used to control the presentation sequence of items.

Must be an unused sequence number from 1 to 899999. Sequences from
990000 to 999999 are reserved and cannot be used. If not entered,
system will generate the sequence no by adding 1 to the last sequence
no. used.

Entry is optional. Enter a valid section code or use the search function to
select from the Section Scan.

Entry is optional. No validation done on this field.

Description of the scope of work. This is a required entry. If more than
30 characters, the text box will automatically pop up to allow entry of
multiple lines of description.

Enter “H” for Major heading or “h” for minor heading or leave blank.
Entry is optional. Enter a valid item type or use the search function to
select from Item Type Scan.

The initial value shown is the nominated default value. The default value
can be changed by entering a valid forecasting method or use the search
function to select from the forecasting method scan.

If adding a child item to an existing Parent Item, then enter the Parent
Item code defined in Parent ltem Maintenance to link this item to a
Parent Iltem. Leave blank if item is not a child item.

Enter quantity of scope of work. Entry is optional.

Enter the unit of measure e.g. each, metre. If left blank, then value will be
set to “UOM”.

The sell rate is the unit price used for claiming. Entry is optional.
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Field

Sell Price

Tag Codes

Exclude from
Claim

Iltem
Completed

Contribute
Prelim
Budget

Prelim
Contribution
%

Description

Sell Price, if entered, must equal to the product of quantity and sell price.
If not entered, then will be calculated by multiplying quantity by the sell
rate.

Enter a valid Tag code or use the search function to select from the Item
Group Scan. Optional.

If not ticked, then the value will be set to “N”.

If not ticked, then value will be set to “N”. It is recommended not to tick
this box.

The entry in the on these two fields will depend on whether job is setup to
include preliminaries in the Schedule Item rates

If Job rates do not manage preliminaries and they are claimed
separately, then

- Contribute Prelim Budget must be un-ticked.
- Prelim contribution % must be zero.

Next Tab Function

Pressing this function will toggle screen formats.

Sequence No Tab.

This tab is used to change the order of the items within the schedule. Changing the sequence
number for an item will move the item to that part of the schedule.
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Se
Item Maintenance & actions @& ok BACK
Job 9088 SOR Demo Project
Direct Cost Budget 9,883,100.21 Budget Finalised Y
Overhead Budget 210,374.27 Contract Sum 12,£77,299.52
Allocated 210,374.27 Budget 10,093,474.61
Available Margin 2,383,8269
SCHEDULE SEQUENCE NO. DESCRIPTION BUDGET QUANTITIES MARGIN OVERHEAD TAGS
Y Hide  Apply < Y eee
Period  ppgaz
o o o === | Fom
TS ™|
Segh  Sect Item Description Quantity UOM Sell Rate SellPrice Exc  I1C  Prel % m
Clm Cont T
1367 2.09 Linemarking N N N
1368 (a) General 1.0000  Item 5,936.5300 593653 N N ¥ 114
1370 (b) Median islands with 1.0000  Item 1,073.1000 1,07310 N N ¥ 114
1372 N N N
1373 an Concrete bin bays N N N
1374 N N N
1375 212 Supply and erect street name N N N
1376 (a) Posts 2.0000 No 280.8200 561.64 N N ¥ 114
13N (b} Road name plates 40000 No 234.8800 93952 N N ¥ 114
1601 N N N
1402 213 Supply and erect signs
& ) e

The other tabs are self explanatory.

Expand/Contract

This function will either display one line of item description (collapse function) or will display the

full description (expand function).

Toggle Price/Budget

This changes the Columns Sett Rate and Sepp Price with Budget Rate and Current Budget.

Variation Section

This positions the user at the start of the Variation section items

Page 28 of 87
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Item Maintenance - Variations & actions @& ok BACK
Job 0088 SOR Demo Project Original Cont Value 10,501, ££3.10 Linked (Transferred) 2,569,926.44
Section No 9500 Variations ) )
Quantity Changes 594 070.0200- Linked (Untransferred)
App Varns (Trans) 2,569,926.44 Unlinked 2337749.72

Unapp Varns (Trans) (ER)

Current Contract Sum 12,477,299.52

HEAD CONTRACT ITEM VARIATION DESCRIPTION SEQUENCE NO

Y Hide  Apply  Clear £ h L
Variation Status Not Submitted Waiting Approval Approved Approved In Principle ] Rejected Withdrawn Period FEB2Z
) o -1l » o -]
[o) Linked @ Unlinked fo) (YINg)
Segh  Item Description H/h M Varn#  Unit Price Budget Margin  Sts w =
15312 Stage 1C (9012) SC 20003 5 84,794.00 84,794.00 A ¥
15313 Stage 1C (9013) SC 20003 5 172,392.00 172,391.00 100 A ¥
15314 Survey (9014) SC 20003 5 28,656.00 28,656.00 A ¥
15315 Shutdown Costs (9015) SC 20003 5 10,499.00 10,499.00 A ¥
15316 Design Changes (9020) SC 20003 5 76,079.00 76,079.00 A ¥
15317 Pump Station (9021) SC 20003 5 168,785.00 168,785.00 A ¥
15318 Margin Adjustment SC 20002 5 1,203,693.47 1,203,693.47 A ¥
15321 Stage 1C Works cm 5 584,187.43

Transfer Section

Options exist to move items from one section to another. These will be presented via Actions
menu Transfer Section. A single item, a selection of items or a range of items can be moved
using Select and Shift key. There are rules when transferring item from one section to another.

Preliminary items cannot be moved to any section

Main Schedule Items cannot be moved to a preliminary section, variation section or preliminary
variation section. It can only be moved to any section within the main schedule

Variation and variation preliminary section cannot be moved to any section
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ltem Maintenance & Actions @& ok BACK
Job 2088 SOR Demo Project
Direct Cost Budget 0,883,100.21 Budget Finalised Y
Overhead Budeet 210.374.27 Contract Sum 12,477,299.52
Copy/Change ltems To
|093,674,51
Appl e
Y PRy < > 283,824.91
SCHEDULE SEQUENCE NO. il
0 P m
Y nide  Apply Seq# Section Item Number Description < > S
534 (a) Insurance as reguired by
ol 545 (b) Site establishment / o o o
Period FEB22 552 (c) Survey and set out
554
Item Description rrent Budget Tagl Tag2 Tag
555 1.02 Traffic control including TMP 3
2.09 Linemarking 502
(a) General 603 | Change Item Environmental management 5,488.87
(b) Median islands witr 505 [ 09218
Copy Item Right-click to show available options
606 1.04 Compliance with Cultural
an Concrete bin bays 607
608 1.05 Clearing and grubbing
212 Supply and erect stree’ 6509 (a) Current stage
(a) Posts 670 (b) Other stages - 1R2 519.29
(b) Road name plates 671 (c) Other stages - 1R3 86867
213 Supply and erect signs
£ > ee
This is the screen where you select items to be moved or copied to another section
Item Maintenance & actions & ok BACK
Job 2088 SOR Demo Project
Direct Cost Budget 0,883,100.21 Budget Finalised Y
Overhead Budget 21037437 Contract Sum 12,477,299.52
Copy/Change Items To : ¥ 7461
. y - . . . - B2e9
Type code & descripton (if not existing) of section to receive copied/moved it
Section Cod
SCHEDULE  SEQUENCE NO. sctonfede 0
Description Only if new section
Y Hide  Apply < S e
Sequence No
o] o] o] o]
< 2
Period FEB22
Seq#  Section Item Number Description Act =)
Item Description 555 1.02 Traffic control including TMP copy rt Budget  Tag1 Tag2 Tag g
2.09 Linemarking 602 caey
(a) General 603 1.03 Environmental management COPY 5,458.87
(b} Median islands 605 copy 20218
606 1.04 Compliance with Cultural COPY
an Concrete bin bays 607 copy
608 1.05 Clearing and grubbing COPY
212 Supply and erect s
(a) Posts 519.29
(b) Road name plat 868.67
| W 0K H ¥ Close ‘
213 Supply and erect s
£ > ee
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This will display the selected items to be moved. The user will have to enter the section code to
receive the items. If section does not exist, user will have to enter the section description and a
warning message “A new section will be created” will be displayed. The user will then have an
option to continue or nominate another section. The sequence number is not required when
moving items. If copying items and the sequence number is not entered, then item sequence
number will be generated by incrementing 1 to last number used. If nominated, sequence can
only be from 1 to 990,000.

When items are moved, they will be moved to the nominated section and sequence no, if
entered.

Copy Single Item

Option exists to copy an item or a copy a range of sub items from another item. Following rules
apply when copying items

e Preliminary items cannot be copied to any section
¢ Main Schedule Items cannot be copied to preliminary section.
e Parent Item cannot be copied.

Item Maintenance & actions @& ok BACK
Job 9088 SOR Demo Project
Direct Cost Budget 9,883,100.21 Budget Finalised Y
Muarhaad Rudoat TN IT4 3T Cantract Som 12,477,299.52
Standard Item Reproduction ®
10,093,474,61
Copy from 2,383,824
Job oosg] o]
SCHEDULE SEQUENCE NO. DES Seq No o
¥ Hide  Apply Section D £ > eee
Item o]
fo] _— - O p

Start Line ool

Period  FEB22
erio Finish Line o999 £

Item Description Copy to Current Budget Tag1 Tag2 ';agEE
Job 2088
2,09 Linemarking 520 o o)
(a) General Section 7‘0 5,488.87

(b} Median islands with 992,18

Item o]

Start Line oooot

n Concrete bin bays o - ] ]
If a new item is to be created, then it will be created with details be
Description o]
212 Supply and erect street nar Quantity
(a) Posts Unit 519.29
(b) Road name plates nate 868.67
213 Supply and erect signs | W OK H x Close

This is the display where you can copy an item or copy a range of sub items from another item.
If copying to a new item, user can nominate a description, quantity, unit of measure and rate for
the new item. If left blank, then it copies the values from the source item.
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Bulk Transfer Section

Option exists to move or copy a range of items. This is presented via Actions menu Bulk
Transfer Section. User can hominate a range of items to move or copy from one section to
another. When moving items from one section to another, following rules apply:

Preliminary items cannot be moved to any other section

Variation section cannot be moved to any other section

Main Schedule Items can only be moved to section within the main schedule
Following are the rules when copying items to another section

Cannot copy preliminaries to any other section.

Cannot copy main Schedule Items to preliminary section

Cannot copy Parent Item

Item Maintenance & actions @& ok BACK
Job 9088 SOR Demo Project
Direct Cost Budget 9,883,100.21 Budget Finalised Y
Overhead Budget 210,374.27 Contract Sum 12,£77,299.52
Allocated 210,374.27 Budget 10,093,474.61
Available Margin 2,383,8269
SCHEDULE SEQUENCE NO. DESCRIPTION BUDGET QUANTITIES MARGIN OVERHEAD TAGS
Y Hide  Apply £ h L
Je) Bulk Copy/Change Section X o) o) o)
Period  FEB22 Seq No Section Item
From | o] o] o] |
Item Description To D D D {Budget Tag1l Tag2 ;ag =
2.00 Linemarking Change/Copy to Section D
(a) General Section Description Only if new section 5,488.87
(b} Median island  Change or Copy Section/s ® Change O Copy 99218
Starting Sequence No D
an Concrete bin bay -
| v OK H ¥ close
212 Supply and erect

This is the display where you can enter the range of items to be copied or moved to another

section

Bulk Item Copy

Options exist to copy a range of items. Rules stated above will apply when copying items from
one section to another.
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Item Maintenance & actions & ok BACK
Jab 9088 SOR Demo Project
Bulk Item Copy - Select Items for Copy *
T Apply & > e 172
161
o o o (5]
!
fo) fo) (v )
SCHEDULE SEQUENCE N
Seg# Section Item Description Selected 3
¥ Hide Apply 555 1.02 Traffic control including TMP N < oo
fo) 602 N fo) fo)
Pericd | FEBZ2 603 1.03 Environmental management N
605 N
iz LEEITY 606 1.04 Compliance with Cultural M Fudget LR 'al'ag =1
H P 607 N
2.09 Linemarking | SeleTt}forCDpy
608 1.05 rubbin N
(a) General Remove Selection e & >,488.87
(b} Median islan 609 SEENUNAIAT N 902,18
670 (b) Other stages - 1R2 N
rhy| Concrete bin ba 67 (c) Other stages - 1R3 N
672 N
212 Supply and erec 673 1.06 Topsoil management (net solid N
(a) Posts 674 (&) Strip topsoil 25mm thick M 519.29
(b) Road name | 675 (i) Current stage M 868.67
703 (i) Other stages - 1R2 M
213 Supply and erec 704 (iii) Other stages - 1R3 N
Co e £ see
py i Select ¥ close

This is where user can select items to be copied. A range of items or selection of items can be

selected using the Select and Shift Copy.

Item Maintenance & actions @& ok BACK
Job o088 SOR Demo Project
Bulk Item Copy - Select Items for Copy x
152
¥ Apply < > eee
+61
o o o 91
~ ~ (i)
g Item Copy ®
| If section is left blank, then item will be copied with same section. -
< 2>
i e
Peri Copied From Seqn  Copied From Section Copied From Item Copied From Description Copied To Section Copied To Item =
555 1.02 Traffic control including TMP 1.02
Iter
602 =3
2.0 G603 1.03 Environmental management 1.03
605
606 1.04 Compliance with Cultural 1.04
607
211 608 1.05 Clearing and grubbing 1.05
600 (a) Current stage
210 Insert copied items before sequence number D {Blank - Copy items at end)
| W OK || ¥ close
213 Supply and erec rus T UUIET STaEes = 1y L T
| Copy || S Select || ¥ Close | < > e
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This will display the selected items to be copied and user will have to nominate a new section or
an item or both. If sequence number is not entered, then sequence number will be generated
by adding 1 to last number used. If entered, sequence number can only be from 1 to 899999.

Show/Hide Child

By default, Child Items and Parent Item are displayed. Using this option will only display the
Parent items.

Spread Overhead budget

When additional budget is made available via a remeasure of the schedule, the user has
options as how to spread this additional budget to existing overhead budgets. Refer to SOR
parameter for the spread option. If additional budget is to be spread by the automatic option,
and budget has been finalised, then an Actions panel option Spread OH Budget in Iltem
maintenance is used to automatically spread the additional budget to existing sub items in the
prelims items, in the ratio of the current budget.

Selecting this displays the following screen.

Item Maintenance & actions @& ok BACK
Job 9088 SOR Demo Project
Direct Cost Budget 9,883,100.21 Budget Finalised Y
Overhead Budget 211,689.29 Contract Sum 12,£77,299.52
Allocated 210,374.27 Budget 10,094 589,73
Available 111532 Margin 2,382,709.79
SCHEDULE SEQUENCE NO. DESCRIPTION BUDGET QUANTITIES MARGIN OVERHEAD TAGS
Y Hide  Apply £ > o
o -0 HOL- DO
Period  FEB22
Spread OH Budget x|
Item Description ge Exc IC  Prel
Total OH Allocated OH Available OH L ot
New Dust Control 1 Main Schedule OH Budget 211,489.29 10,376.27 111512 92 N N Y 3.00
O variation OH Budget N N N
1.08 Subgrade prep: N N N
() Roads | v 0K H Xclose | 56y Ny 3.00
(b) Fire trail N N N
cm N N N
1.09 Final trim:- cMm N N N

The box can be checked, and OK selected. This will spread the $1,115.12 across the budget on
all preliminary items in the ration of the current budget.

=
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Adding Sub Items (Budget Lines/Resources)

Sub Items can be created as part of the Expert Estimator load, manually entered, as individual
items, or a grouped of sub items from another item are copied to another item.

Sub items are the budget details of an item. They are lists of the measurement and costs of all
resources that will make-up the item budget. These budget lines are associated to a cost
centre.

Sub item lines without a cost centre will be treated like a comment line. They can be a blank
line; can have a description, quantity, unit of measure and cost but the cost will not be included
in the budget.

The sub item lines maintenance program will be presented via the right mouse click option
SELECT on the Item Maintenance program. The initial screen to be displayed will depend on
the default screen format nominated on the system parameter “SUB ITEM” position 1-3. The
screen format codes are displayed on the top right hand corner of the program.

The following are the functions on all sub item screens

Delete all lines

Delete a single line

Use MS Type shift delete to delete a group of lines

Use MS Type Control delete to delete a selection of lines

The text option to display full description or full notes will be displayed as a pop up

window or a word wrap

¢ If more than one of descriptions or notes exists, then notes or description will be
displayed in different colour. An Actions menu Expand/Contract function is available to
either display the full notes/text descriptions or display first line of notes/text. The initial
view is to display one line.

e Copy, paste and move option within the same item is supported with insertion point re-
sequencing. When a paste or move is undertaken, system will calculate the band of lines
required at the insertion point and renumber the following sub item lines.

e Copy, paste and move to another item is supported with lines copied at the end of the
target item number

e Function to view or link to Cost Centre Budget makeup Enquiry Screen.

Function to display Parent ltem summary is provided

e Filters exist in all screens. Any filter used in one screen also applies when other screens

are viewed. Single filter fields are either “Positioners” or text string filters e.qg. for line

number it would be a position and for a description, it would be a text search through the
descriptions.

Adding a New Line

From the sub-item maintenance screen below, select New Line from the Actions Menu. The
cursor will be positioned to the next available line number.
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Item Maintenance & actions @& ok BACK
Job 2088 S0OR Demo Project Budget Finalised Yes
Section SegH g5 Item Type o] FM 15 £ LUMPSUM
Item 2.0 Saw cut existing pavement Parent
FFQ 11.0000 Budget Rate 48,74 Budget 53617 Markup % 216
Curr Oty 1.0000 oM m Sell Rate 52,7200 Sell Price 579,92 Margin 43,75
RESOURCE NAME NOTES/RESOURCE NAME NOTES
Y nide  Apply > e
Period FEBZ2
o oy o]
[ Show 51 With No Current Budget p p
Line Resource Name uom Production Rate Budget Qty Budget Rate Current Budget Cost Code T =}
1 SAW CUT BITUMEN m 1.0000 11.0000 4.0000 44,00 2010 5 N
2 MIsC2 each 27.8181 306.0000 1.0000 306.00 2010 5 N
3 CWs hr 0.0909 1.0000 64,7199 6472 2010 L N
& MOXI WTRUCK DRY hr 0.0454 0.5000 187.0000 93.50 2010 P N
5 WATER CHARGES MRC kL 0.6363 7.0000 31300 21.91 2010 M N
6
7
a
9
10
£ > e
99999 Prelims Component % 5301300 Riaals 6.04 9995 M

Field
Line No
Notes
Description
UOM
Production rate

Budget Quantity

Budget rate

Budget Amount

Cost Centre

Comment Flag

Page 36 of 87
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Description
No need to change the number. Line numbers are already assigned.
Optional
Required entry. Enter a resource name or description.
Enter unit of measure, e.g. HRS, M3 etc. If left blank, will set to “UOM”.
Enter either a production rate or budget quantity.

If production rate is entered, then budget quantity will be calculated as
item quantity multiplied by production rate. If budget quantity is entered,
then production rate will be calculated as item quantity divided by budget
guantity.

If rate is entered, then budget amount will be calculated as budget
guantity multiplied by budget rate.

If budget amount is entered, then budget rate will be calculated as
amount divided by quantity.

Required. Enter a valid cost centre or use search function to select from
the cost centre scan.

Must be N
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Adding Sub Item Comment
All fields are optional except for line no and Comment Flag. Flag must be setto Y.
Current Quantity

When current quantity is changed, then the following process occurs:

e Entered quantity will update the Current Contract Quantity

¢ Original Contract Qty will be updated to equal Current Contract Quantity if budget has
not been finalised. If finalised, the original contract quantity will not be updated

e [fitemis SOR Item UnCoupled (SU), then forecast final will be updated by the same
change in contract quantity

e If SOR item is Coupled (SC), then forecast final quantity will be set to current contract
guantity

e [fitemis lump sum (LS) and budget is not finalised, then forecast final quantity will be
updated by the same change in contract quantity i.e. if current contract quantity is
changed from 10 to 15, then forecast final quantity will be increased by 5. If budget is
final, then current contract quantity cannot be changed.

e Sell Price and Margin will be recalculated

e sub items budget quantity and amount will be recalculated
S| Budget Qty = Curr Qty * Production rate
S| Budget Amt =S| Budget Qty * Budget rate

e If item is to contribute to overhead, then item OH will be recalculated

e Ifitem is a child item, then the Parent Item sell price, sell rate and budget will also be
updated.

e Markup % will also be calculated

Iltem Budget

This is the total of all sub item amounts excluding notes. As lines are added, deleted or
changed, the budget will be also be changed.

Budget rate
This is calculated as budget divided by current quantity.
Markup %

This is calculated as Sell Margin divided by Budget. Changing the mark-up % will change the
sell margin.

Sell Price
Current Quantity x Sell rate.
Margin

Margin is calculated as Sell Price less Budget. Changing the margin will change the sell rate,
sell price and the markup %.

Forecasting Entries

As lines are added or updated, forecasting worksheet entries with the associated notes and
descriptions are also created or updated. Initially, scope of work quantity will equal the budget
gty and earned qty is set to zero. Forecast quantity to go will be calculated as scope of quantity
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less earned quantity, the forecast rate will be set to budget rate and cost to complete will be
calculated as Quantity to go multiply by forecast rate.

Comment lines will also be added to the forecast worksheet entries.

Extended notes are presented via a right mouse click option Extended Notes. This pop up
window will also be automatically presented when entering more than 30 characters of notes.

Preliminary Lines

If an item is to contribute to overhead, the sub item lines will automatically be flagged to
contribute to overhead. An option to exclude sub item lines from contributing to overhead exist
and is presented via Actions menu More Data Function.

When sub item budget lines are added, changed or deleted and sub item is flagged to
contribute to overhead, prelim line is created or updated. The prelim line is the line displayed at
the bottom of the screen where the line number and cost centre is nominated in the Schedule of
rate parameter. The prelim line amount or the item overhead contribution is calculated as a % of
the total sub item lines budgets to contribute to overhead. The prelim % is the % nominated at
item level. See screen above.

The prelim holding item which is defined on the Schedule of parameter will be updated by the
overhead contribution and the contribution will be shown as available overhead budget to
distribute.

More Data

This display will be presented when Actions Menu More_Data option is taken. This will allow
user to mark which sub item lines are to contribute to preliminaries.

When subitems are added, changed or deleted on preliminary items, the available OH budget is
being changed and a reversal line is being created on the prelim holding item.

As subitem lines for preliminary items are entered and budget is allocated, the budget used
comes from the contribution of each Schedule Items. In the screen above, the Original
Overhead is the sum of the prelim contributions for the original budget of all payitems, The
generated budget is addition budget available form remeasures of original Schedule Items (this
could be negative if remeasures down occur).

When additional budget is made available via a remeasure of the schedule, the user has
options as how to spread this additional budget to existing overhead budgets. Refer to SOR
parameter for the spread option. If additional budget is to be spread by the automatic option,
and budget has been finalised, then an Actions panel option Spread OH Budget in ltem
maintenance is used to automatically spread the additional budget to existing sub items in the
prelims items, in the ratio of the current budget.

Individual overhead budget sub items can be marked to not receive any additional budget that
may be made available. If the automatic spread method is used, the amount of the budget that
would be allocated to those sub items marked to not receive additional budget, is placed in this
nominated cost centre. This budget can be used as contingency or as a gain for the project.
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Budget Transfer within Item Maintenance

This functionality enables the resource mix for a particular Schedule Item to be changed to
reflect how the work will be carried out, without losing integrity of the budget, i.e. The total
budget for the Schedule Item before the change in resource mix will still be the same after the
change.

If earned budget exist and has changed, program will display a warning message before
continuing with update.

The screens used for this function are the same as for standard Iltem Maintenance, but with
some restrictions.

Full Item Maintenance can be made available only to those users who have authority and
knowledge to change the Schedule prices, budget and margin. This Budget Transfers version of
ltem Maintenance can be made available to engineers and site staff who are managing the
work methods for Schedule Items.

When the resource mix for a Schedule Item is changed, the change must be completed fully, or
the system will return the Schedule Item resources to their original state.

To use this function use menu options
Projects>Job setup and Reports>Schedule of Rates>ltem Maint-Bud Transfer

This displays the following screen.

Item Maintenance - Budget Transfer & actions @& ok BACK
Job 9088 SOR Demo Project

Direct Cost Budget 9,883,100.21 Budget Finalised Y
Overhead Budget 211,689.29 Contract Sum 12,£77,299.52
Allocated 210,374.27 Budget 10,094 589,73
Available 111532 Margin 2,382,709.79

SCHEDULE SEQUENCE NO. DESCRIPTION BUDGET QUANTITIES MARGIN OVERHEAD TAGS

Y Hide  Apply < > e

o -0 HOL- DO

Period  FEaz2

Item Description Hd Tp FM Par Quantity UOM Sell Rate Sell Price Exc  IC  Prel
Chd Clm Cont
cMm N N N
2.05 Asphaltic concrete surfacing cm N N N
(a) Flush seal (Tmm LS 7,776.0000 m 31500 24,894.50 N N 112
(b) 30mm average compacted M N N N
(c) 35mm average compacted cMm M M M
(d) 50mm average compacted LS 953.0000 | t I 292576 N N ¥ 114
SeL%ct
cm . M NN
Extended Description
2.06 Supply 32ZMPa concrete CM . N N N
Variation
(a) Roads and driveways cm N N N
cMm N N N
2.07 Supply and lay concrete kerb cm M M M

Changes to Forecasting Method, rates and prices, cannot be made in this screen. Also new
Items cannot be added, or existing items copied.
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The Actions options are described in the Item Maintenance section of this manual.

The main function is to select an item and change the resources for that item. To do this take
the Select option from the right mouse click options.

Item Maintenance - Budget Transfer & actions @ ok BACK
Job 2088 SOR Demo Project Budget Finalised Yes
Section Seqg# 176 ltem Type FM LS LUMP SUM
Item (d) 50mm average compacted Parent
FFQ 953.0000 Budget Rate 216.28 Budget 20611515 Markup % 816
Curr Oty 953.0000 UOM t Sell Rate 233.9200 Sell Price 22292576 Margin 16810.61
Resource Budget 203791.83 Unallocated Budget Budget Adj (BA) Factor 1000000442 Calc Subitem
Earned Value 203791.92 Revised Earned Val 203791.92 Item Level EV Factor 1.000000000

|:| RESOURCE NAME NOTES/RESOURCE NAME NOTES EARNED VALUE EARNED VALUE FACTOR RESOURCE RATE/AMT BUDGET ADJUSTF.’IG

Y Hide  Apply L
Period FEB22
ol o ey o]
O Show 51 With No Current Budget o] o]
Line MNotes Resource Name uom Budget Oty Budget Rate Cost Code cT C =]
1] 1=(7776*0.05th*2.45t) (0Q 50MM ASPHALT STAGE 1R t 9811368 207.7099 2110 5 N
2 2=%(1,3) ¥
3
&
5
6
7
8
£ > see
99993 Prelims Compenent % 203,791.9200 0.0114 9995 M E
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Field

Resource Budget

Unallocated
Budget

Budget
Adjustment Factor

Calculate Subitem

Earned Value

Revised Earned
Value

Item Level EV
Factor

Description

This is the current budget for the Schedule Item. It is the sum of the resource
budgets for that item. This will change as resources are changed.

As changes are made to resource mix, this will reflect the difference between the
Resource Budget and the fixed current budget for the Schedule Item.

This is the current budget for the Schedule Item/total of the budgets for the
resources for the Schedule Item. It wall always start at 1.000000000.

This flag will determine if budget and earned value factor will be automatically
applied for each subitems. A value of “Y” will apply the item budget adjustment
factor to the subitem resource rate to get the subitem budget rate and item level
earned value factor to the budget amount to get subitem earned value. A value
of “N”, then subitem values will be calculated from subitem quantity X budget
rate. Quantity done, earned value factor and earned value are input capable
only when the flag value is “N”.

The initial pay item earned value.

This is the current earned value. It is the total of all the subitems earned values.

It is expressed as the initial earned value over the current budget at item level. It
represents the even spread to sub items that will result in re-allocation of the sub
item earned value. Where the Calculate Subitem Flag is Y, then the earned
value factor will be automatically applied to the subitem budget to get the
subitem earned value.

Additional options that appear in the Actions menu are described as follows.

Field

Accept Updates

Apply Bud Ad
Factor

Description

When this function is pressed and unallocated budget exist, program will prompt
a message “Undistributed budget exists. Continuing will result in no update with
all changes lost”. If revised earned value is not equal to the initial earned value,
program will display message “Undistributed earned value exists. Continuing will
update budget and earned value with changes”.

This function will update sub item details with recalculated budget quantity, rate
and amount, the new budget rate will be preserved in the current rate and the
new resource rate will be the forecast rate. Earned value will be updated and
recalculated depending on the value contained in Calculate Sub item flag. All
existing PMW entries will be deleted and replaced with the new subitem break
up. FFQ will be updated by the change in budget Qty and forecast gty to go will
be calculated as FFQ — Qty done. If earned value is changed, then change will
flow at item level.

Pressing the Apply Budget Adjustment factor will recalculate the subitem rate
and amount displayed on the screen. It will not at this point update the file.
Where the Calculate Sub Item is set to “Y”, then the item budget adjustment
factor will be applied to the resource rate to calculate the new budget rate. The
item earned value factor will be automatically applied to the subitem budgets to
calculate subitem earned value. Where flag value is “N”, then budget rate will be
calculated
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Importing a Schedule from Expert Estimation

This section will cover how to upload the Item / Sub Item Structure from a csv file downloaded
from Expert Estimation. An upload from any estimating system could be done via this method,
providing the output from the estimating system can be in the same format. This layout is in an
appendix.

The following are the steps required to upload a Pay Schedule from Expert Estimation

e Setup atemplate job if it does not exist. The Template Job defines the cost centres that
are permitted on the project. The cost centres form this template will be used to create
the project cost centres during the load process.

e Setup a SOR Job. To setup the job, refer to section, setting up a SOR Job.

e Setup required section codes. To setup section code, refer to section, Setting up
Section code

o Setup SOR Parameter. To setup the parameter, refer to section to Setting up SOR
parameter

¢ Run the upload program

Maintain Upload Parameters

To access Setup SOR Parameters from the Jobpac main menu, select Projects>Job Setup and
Reports>Expert Upload / Setup>Set SOR Parameters.

Refer to Setting up SOR parameter on how to setup parameters for Schedule of rates jobs. The
upload requires that preliminary section defined in the SOR parameter record will allow for
multiple preliminary items.

Format of Upload File
For presentation purposes, the Template is described in three separate components.

Providing the project data can be described as per this template, it can be uploaded.

First Component.

EKpE rt Esti matiﬂ n U p Iﬂad Te m p Iate Please check which line daota should begin on ond delete columns headin
. Schedule L. .
Sequence # Trade/Section : Sub ltem Description [ Notes Margin % Resource
Item Code
6.0 N 45 12 A 50N 2000 A 5 A 10 A
1000 Al Build Footpath
1001 Al 1 100 M3 required
1002 9000 P.1 Staff
1003 9000 P.1 1 Part time PM required
1004 9000 P.1 2 Part Time SE required
Column Description/ comments
Sequence No This must exist for every line in the upload, and must be unique. It
determines the order of presentation in screens and reports.
Trade/Section No mandatory, except for Prelims Items, in which case it must be 9000. On
upload this will be replaced by the prelims section defined in the SOR
Parameter
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Column

Schedule Item code

Subitem

Description/Notes

Margin %

Resource

Second Component

Description/ comments

This is the Schedule Item code. It can be blank. All subitems related to a
SOR Item must have the same Schedule item Code.

This must be blank for SOR Items, and must be present for Subitems

For SOR Items this is the description of the SOR Item. For Subitems it is
used for the Notes Field for Subitem displays.

This is not used

This is only used for Subitems, if the Resource/Activity function is turned on
for the project. This is different to Resource Names or Resource
Descriptions associated with SOR Projects.

Quantity ltem Overhead Margin Amount
154 N 5A 154 N 154 N 154 N 154 N
100 M2 100 8000 1000 1000
100 M3 80 8000
5 HRS 100 500
5 HRS 60 300
Column Description/ comments
Quantity This is Quantity for both SOR Items and Subitems
UoM This is UOM for both SOR Items and Subitems
Rate This is Rate for both SOR Items and Subitems
Value This is Budget for SOR Items and Subitems. For SOR Items is it NOT QTY

Item Overhead

Margin Amount

Third Component

* Rate. This value for SOR Items should equal the sum of budgets for all
subitems related to that SOR Item. For Subitems, if this has a Heading Type
of TEXT, it must be zero

This is only applicable to SOR Items, and is that component of the Item
value assigned to Overheads. It will only have a value if the Spread Prelims
function is active for the project.

This is equal to QTY * RATE — Value - ITEM Overhead

Resource

Cost Code Cost Type Description Forecasting Method Parentltem Seq# Heading Type Item Type
BA 24 30 A 2A 6.0N 10 A 2A
sC
1002 MT 10MM Gravel
5C
1001 LB Project Manager
1001 LE Site Engineer

Page 43 of 87
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Column Description/ comments

Cost Code This must be present for all Subitems, unless the Subitem line has a
Heading Type of TEXT, in which case it must be blank, and blank for SOR
Iltems.

Cost Type This must be present for all Subitems, unless the Subitem line has a
Heading Type of TEXT, in which case it must be blank, and blank for SOR
Iltems.

Resource Description This is the Resource Description or Resource Name for Subitems. It is blank
for SOR Items.

Forecasting Method This must be present for all SOT Items, and one of SC, SU, LS, CM, RO
Parent Item Sequence  This is only applicable to SOR Items, and only if the load is actually from
No Expert Estimation

Heading Type The options here are HEAD1, and HEAD2, and TEXT. HEAD1 and HEAD2

will provide subheadings and Subtotals within the SOR Schedule. TEXT is
used for Subitem lines that are just description only and do not contribute to
the Budget.

Loading an Estimate

Once the parameters have been setup for the job relating to the estimate you are loading and
the Expert Estimator file has been uploaded to the Holding file on the server you are ready to
load the estimate. This upload to a Holding file will be setup by your Jobpac consultant.

To access the Expert Upload from the Jobpac main menu, select Projects>Job Setup and
Reports>Estimating Interfaces>Expert Estimation>SOR Upload

When the Expert Upload to Jobpac is selected from the menu the following screen is displayed.

Expert Estimation Upload (=] & actions & ok BAC
Job for the upload file SORPRO Q

[ Create item structure and cost budget

Evenly Spread Total OH Budget Across All Pay Items

Report Option ® PDF O Excel

View the report
Please enter cost centre for the following provisional subitems -

Item Code Line Description Unit Quantity Rate Amount Cost Code T

| (Mo records to display)

Expert Estimation Upload

Complete the fields as follows:
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Field
Job No
Create claim

structure and cost
budget

Evenly Spread Total
OH Budget across all
Schedule Items

Cost Centre

Report Option

View Report

Description

The Job must be schedule of rates job and a template job has been
associated to the job.

Set this to N if doing an initial load and want to check if all lines are valid.

Set to Y when there are no invalid lines. By setting this field Y, the load
process will update Jobpac. The update will only occur if there are no
validation errors.

Set this to Y if total Over Head budget is to be evenly spread across all items.
Total Over Head budget is the total of the overhead amounts for all Schedule
Items. The prelim contribution % will be calculated as total Over Head budget
divided by total direct costs. The calculated % will then be used to calculate
each Item Prelim Overhead by multiplying the % by each item total direct
cost.

Set this to N if overhead is not to be evenly spread across all items, i.e. the
amounts nominated for each item will be used for that item. (This option not
generally used.) Or if overhead spreading function is not used.

The sub item lines shown on the screen are provisional Iltem from the
schedule. Upload will identify all provisional items and sub items with a “PS”
in item type. Expert Estimation has no facility to record a cost centre for
provisional budgets. User must input the cost centre to be used for the
budget for provisional sub item. Cost centre, if entered, must be a valid cost
centre from the template job or user can use the search function to select
from the cost centre scan window. This feature is only used if the upload is
from Expert Estimation

Select Spool file, PDF or Excel.

If you select this box, the report will be displayed on screen prior to printing.

When project is uploaded, it will automatically be copied to an “Original State” files, for audit

purposes.

File can be re-uploaded if the following criteria have been met

Budget has not been finalized

No claims made against any of the item

No quantity done

Variation Schedule Items are not linked to variations

When re-uploading, upload will delete existing Schedule Items, sub items, worksheet entries,
notes and descriptions including the “Original State” files. Cost Centres will be deleted if there
is no cost committed against the cost centre. If there is, then budget and Forecast cost to
complete will be set to zero, Forecast Final cost will be set to committed cost and Gain/loss will

be recalculated.

Expert Upload Validation Report

A sample of the validation report produced by the upload program is embedded in this sheet.

Use the Excel option, so you can filter on the Error column.
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<t
Adobe Acrobat
Document

The validation report will list all lines regardless if the line is valid or not. Erroneous lines are
flagged with starting error description of #ERR. If the uploaded item contract value is not the
same as the calculated value and the difference is within the allowable variance defined in the
system parameter EXTVAR, then a warning message will be printed. If not within the allowable
variance, then an error message will be displayed. Uploaded item value is the sum of the direct
cost, overhead cost and margin. Calculated item value is quantity (EIQTY) * rate (EIRATE).

When there is rounding difference between the parent and sum of the child items, the upload
will create a rounding item where rounding item value will be set to the difference. The rounding
items will be printed at the end of the report.

Totals are printed at the last page of the report.
Total Overhead Budget (Schedule Item Level) is the total of the uploaded overhead.

Nominated OH (Allocated OH) is the sum of the prelim section sub item lines. Prelim section
will be have section code as defined in the SOR parameter.

Unallocated OH will be equal to the difference between Total Overhead Budget (Schedule Item
Level) and Nominated OH.

Contract Sum is total of the calculated item value (Qty * rate)

Direct Cost Budget is the total of the sub item lines budget

Overhead budget is equal to the overhead budget at Schedule Item level
Total budget is the sum of direct cost budget & overhead budget

Margin is calculated as the difference between contract sum and total budget
Total number of records will be printed.

Total invalid records will also be printed.

When the file is uploaded,

The “9000” trade section will be replaced by the Preliminary section defined on the Schedule of
rate parameter.

Forecasting method of provisional items will be set to “RO” and will not update the contract sum,
budget and margin.

Parent code of parent item will be generated starting from AA, AB, AC, AD etc. The upload will
add the code to the parent code table.

Project contract sum, budget and margin will be updated.
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Finalising the Budget

Finalising the budget on a project in Jobpac locks in the Original numeric data, i.e. contract
value, budget, margin on Schedule Items and Sub Items (Resources).

Changes can be made after budget finalisation, but these are tracked. The budget changes
made can be viewed via the Budget Adjustment Report.

At time of budget finalisation, ALL details of Schedule Items, and Resources, including
descriptions are written to “Original” files. This data is used if “Build from Sub items” option is
used in PMW by item.

Un-finalising a budget may be possible, and your Jobpac consultant should be contacted if you
believe this is necessary.
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Earned Value

In Jobpac, Earned Value is the term used to describe the function of comparing the budget
value of work done on a project and comparing it with the cost value of the same component of
work. Budget value of work done is calculated by measuring the quantities achieved. The cost
value of work done is the actual cost to date (i.e. authorised and posted costs) plus the value of
goods delivered and services completed but not yet authorised for payment.

With SOR projects, the measurement is done by measuring the actual quantities achieved for
each Schedule Item, forecasting the final quantity for that Schedule Item, calculating the % of
work completed, and multiplying by the budget for that component of work.

Earned budget is calculated for each cost centre on the project, and then this is compared with
the cost of work in progress for that cost centre. When this is completed, the Financial Status
Report will show the comparison for each cost centre and the project.

Steps to establish Earned Budget for the project are:

e [Establish Forecast final Quantities for each Schedule Item and enter into system.

¢ Measure quantities done for each Schedule Item and enter into the system. An option
exists to copy claimed quantities into the Earned quantities screen.

e For Schedule Items where the resources are not deployed evenly throughout the project,
then a more detailed measure can be done at the resource level within each Schedule
Item.

Forecast Final Quantities

The screen to enter Forecast final Quantities for the Schedule Items can been configured to
allow entry only of Forecast Final Quantity. Other configurations are available via parameter
FFQDEF.

To update Forecast by Item from the Jobpac main menu, select Project>Job Setup and
Reports>Schedule of Rates>SOR Job Forecasting>Forecast Final Quantities.

When the Forecast Final Quantity is selected from the menu a job selection screen is displayed.
Enter the Job number or use the Job search function to search for the required job.

The following screen is displayed:
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Forecast Final Quantity Entry & actions @& ok BACK
Job o088 SOR Demo Project
Contract Sum 12,£77,299.52
Current Claim Amount 8,052,543.81
Current Earned Budget 9,697,606,93
SHOW CLAIMED FORECAST FULL DESCRIPTION SEQUENCE NO TAGS VARIATIONS
Y Hide  Apply r < D
Period  FEB22
fo) 5 0 - 0
Item Code Description Cmp Unit FM  Par Chd Claimed Qty F'cast Final Qty Oty Done F'cast Oty To (B2
n Fees and Insurances N Item LS 1.0000 1.0000
5 Insurance Excess N Item L5 AE 1.0000 1.0000
6 Rework N Item L5 AE 1.0000 1.0000
Stage 1C N Item LS 1.0000 1.0000
(a) Insurance as required by M IT LS 1.0000 1.0000
(b) Site establishment/ N IT LS 1.0000 1.0000
(c) Survey and set out N IT L5 1.0000 1.0000
1.02 Traffic control including TMP N IT Ls 1.0000 1.0000
(a) Cut existing working N M LS 158.0000 158.0000
(a) Rip, mix and trim N SM LS 1,575.0000
(a) To footpaths, allotments M HA LS 0.9500 0.9300
2.01 Saw cut existing pavement N Lm LS 9.0000 2.0000
(a) Base course - Type 211 N cm LS 151.0000 151.0000

Forecast Final Quantity Entry

Only the Forecast Final Quantity (FFQ) for each Schedule Item is entered. Entering these
quantities will cause the associated quantities related to the sub-items within each item to be
changed by the same % value. It will also calculate the earned budget for each of these cost
centres related to the individual sub items. For example, if the FFQ is 1 and this is changed to 2.
Then the FFQ of all sub items (resources) will also be doubled.

The relationship between FFQ, Qty Done, and Qty to go, must be maintained. When a FFQ is
changed, the Qty Done will always remain unchanged, and the Qty to go will change to maintain
the relationship. This means the quantities to go in the forecasting worksheets will change. This
will immediately affect the forecast final cost for cost centres.

If the Forecasting Method is SC, then the Current Contract Quantity will also change to the
same value as the FFQ, with a corresponding change in budget for that item.

The Forecasting Method can be changed in this screen. The business rules associated with
this change are described in the Forecasting Method section and Item Maintenance section of
this manual.

Additional tabs are available displaying Sell Price, Long Description, Section, Sequence
number, Tag Codes, and Variation links.

Forecast final Quantities are not entered for Parent Items, but are entered for all child items.
The system automatically calculates the FFQ for a Parent Iltem based on the children.

The Tags Tab can be used to filter the Schedule Items, by all available codes.
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The Variation Tab shows only those Schedule Items that are in the defined variation section of
the schedule. It shows if the Schedule Items are linked to a variation or not.

The other options which may be available, depending parameter CPYCDQ, are:

Copy Qty Done to Claim Qty Selecting this option will copy all of the Done quantities to
the Claimed to date quantity in the Progress Claim screen.

Copy Claim Qty to Qty Done Selecting this option will copy all current claimed to date
gquantities to quantities done. The Forecast Quantity to go will also be changed and Forecast
Final Quantity will remain fixed.

Enter Earned Quantities

Once Final quantities have been established, then quantities achieved to date can be entered
for each Schedule Item, this will enable the Earned budget to be calculated for each Schedule
Item, and for each cost centre on the project.

The percentage Qty Done/FFQ (i.e. percentage complete) calculated for the Schedule Item is
used to adjust the Quantity done for each sub item related to the Schedule Item, i.e. if
percentage complete is 60%, then the quantity done for each sub item is changed to 60% of the
FFQ for that sub item.

Earned Budget = Quantity Done/Forecast final Quantity * Current budget.

An earned budget is calculated for each sub item for the Schedule Item. Each sub item has a
cost centre, so the earned budget for each cost centre is generated. This is compared with the
CWIP for that cost centre to establish a productivity to date for each cost centre and the project.
The Financial Status Report best shows this information.

To update Entering Earned Quantities from the Jobpac main menu, select Project>Job Setup
and Reports>Schedule of Rates>SOR Job Forecasting>Enter Quantities Done.

Enter the Job number or use the Job search function to search for the required job, click OK
and the following screen is displayed.
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Calculate Earned Budget for ltems & actions @ ok BACK
Job 2088 SOR Demo Project {Budget Finalised
Current Budget EB This Period EB To Date CWIP To Date Variance To Date
Project Totals 10,094,589.70 2,437,697.87 9,699,189.42 10,611,062.51 911,853.09-
Filtered Totals 7,827,701.93 22,740.05- 7,228,951.50
QUANTITY DONE DESCRIPTION SEQUENCE NO AUDIT VARIATIONS
Y Hide  Apply ? IR ¢ > eee
fo] PP PO
For Period  FEB22
Item Description Contract Quantity B/ F Unit Tp FM Pc Forecast Final Quantity Done % Comp Upd
Quantity Sis 7
5 Insurance Excess 1.0000 B Item LS AE 1.0000 1.0000 100.00 N
6 Rework 1.0000 B Item LS AE 1.0000 1.0000 100.00 N
(a) Insurance as required by 1.0000 B IT LS 1.0000 ¥
(b) Site establishment/ 1.0000 B IT LS 1.0000 Y
(c) Survey and set out 1.0000 B IT L5 1.0000 ¥
1.02 Traffic control including TMP 1.0000 B IT LS 1.0000 Y
(a) Cut existing working 158.0000 B M LS 158.0000 Y
(a) Rip, mix and trim 1,575.0000 B SM LS 1,575.0000 3650 Y
(a) To footpaths, allotments 0.9300 B HA LS 0.9300 ¥
2.01 Saw cut existing pavement 2.0000 B Lm LS 9.0000 ¥
(a) Base course - Type 211 151.0000 B cm LS 151.0000 Y
(b) Sub-base course - Type 197.0000 B cm LS 197.0000 ¥
Field Description

Contract Quantity
B/F

Forecast Final Quantity
Qty done to date
% Complete

Calc Sis

There are four other tabs.

Current contract quantity for the Schedule Item

B : Contract Quantity EQ Forecast Final Quantity
F : Contract Quantity NE Forecast Final Quantity
Quantity established in the FFQ entry screen.
Quantity Done. Cannot be greater than FFQ.
Quantity done/FFQ

If this is Y, then the % complete is transferred to each sub
item related to this Schedule Item. Quantities done for
each sub item are adjusted using the same %.

If this is N, then the system prevents the calculation
transferring to the sub items. This is automatically set to N
if changes are made directly to the sub item quantities.
See next screen.

The Audit tab will show who last updated the Schedule Item Quantity, and the date and time.
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The Variations tab will show only those Schedule Items within the Variation Section of the

schedule.

The Actions menu option Detail/Summary,

screen one at a time. Selecting this displays the following screen.

provides detail about each Schedule Item on

Note: When selected the first line on the screen is displayed, and user should use the page
up/down marks to display the required Schedule Item.

Calculate Earned Budget for ltems & actions @ ok BACK
Job 2088 SOR Demo Project {Budget Finalised
Current Budget EB This Period EB To Date CWIP To Date Variance To Date
Project Totals 10,094,589.70 2,437,497.87 9,600,189.42 10,611,062.51 911,853.09-
Filtered Totals 7827701.93 22,740.05- 7,238,951.50
QUANTITY DONE DESCRIPTION SEQUENCE NO AUDIT VARIATIONS
Y side  Apply T G e
o PO P |
For Period  FEB22
Item Description Contract Quantity B/  Unit Tp FM Par Forecast Final Quantity Done % Comp Upd
F Quantity Sis 7
(a) Rip, mix and trim 1,575.0000 B SM LS 1,575.0000 575.0000 3650 Y
£ > e
[2]
Budget Budget Budget Budget FFQty  UOM Qty Done  %Compl Earned Budget
Quantity ~ UOM Rate Amount
Orig SM
Prev
Curr 1575.0000 SM 27521 433461 1575.0000 575.0000 36.5 1582.49 B

If Schedule Item is 100% earned, the Earned budget may be less than the current budget. This
is because the overhead contribution amount for Schedule Items is not included in the earned
budget calculation.

If the % complete for sub items is not the same as for the Schedule Item, then sub items can be
directly remeasured. To do this select the Schedule Item, and all the sub items for the Schedule
Item are displayed.

The option Claimed to Qty done in the Actions menu, will copy the claimed quantities for

every Schedule Item that is currently filtered on this screen. A message is displayed before this

happens.

Confirm

o

Only filtered items will be copied.
Quantity Done will be updated with Claim Quantity.

=+ Copy will nat be done for Pay [tems marked 'N' (Don't Recalculate Subitems) **+*

***|f copied guantity is greater than the FFQ, then the Quantity Done will be set to FRQ **

[ W Yes

| X |
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Copies quantities will change colour to indicate a copy has been done.

If the % complete for sub items is not the same as for the Schedule Item, then sub items can be
directly remeasured. To do this select the Schedule Item, and all the sub items for the Schedule
Item are displayed.

Calculate Earned Budget for Qty Done & actions @ ok BACK
Job 9088 SOR Demo Project (Budget Finalised)
Seq# 15419
Section 9500 Variations
ltem (&) Rip, mix and trim
Variation No 20004  Stage 1C @ Status A *Approved Transferred Y
Current Earned Budget 1,582.49 Current Budget 533461
Previous Earned Budget Direct Cost Budget 533461

Overhead Budget

COST CENTRE NOTES/RESOURCE NAME

Y Hide  Apply > e
[0 Show SI With No Current Budget
D — —
For Period  FER22
Line MNotes Resource Name Unit BF Forecast Final Oty Qty Done % Comp C =}
11 B Y
2 2=(1575[#QTV]) in m2 B 1,575.0000 ¥
7 7=(5.25[#lg6]) GRADER12G hr B 5.2500 1.9167 365 N
8 8=(5.25[#lg6]) ROLLER hr B 5.2500 1.9167 365 N
9 9 =(5.25[#lgs]) V-MOXI WTRUCK DRY hr B 5.2500 1.9167 365 N
10 10 =(5.25[#lg6]*load per V-WATER CHARGES MRC kL B 147.0000 53.6667 365 N
1 12 =(5.25[#lg6]*1) 14T EXC hr B 5.2500 1.9167 365 N
12 13 =(5.25[#lg6]*1) V-CWs hr B 5.2500 1.9167 365 N

Changing the Quantity done for a Schedule Item or for a sub item will change the quantity to go
in the forecasting worksheets, and change the forecast final cost for each cost centre
associated with the change.

Field Description
B/F B : Contract quantity EQ Forecast Final Quantity

F : Contract Quantity NE Forecast final quantity

Forecast Final Quantity Initially; the budget quantity for the sub item.
Qty done to date Quantity Done. Cannot be greater than FFQ.
% Complete Quantity done/FFQ

C If this is Y, then the line is a comment line

If this is N, then it is a line that can contribute to earned
budget.
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Actions Options Description
Detail/Summary As for the Schedule Item, this can be used to see the
detail of each line item, one at a time.
Next Item/Previous Item Allows user to move to next or previous item without
having to go back to the Schedule Item itself.
Expand/Contract Expands and contracts to show the full description of the
sub items

Initially the sub items have the same % complete as the Schedule Item. The FFQ and Quantity
Done for each sub item can be adjusted to reflect the correct measurement for that sub item,
and a more accurate earned budget. On returning to the Schedule Item screen the % complete
will have been recalculated to reflect the changes at the subitem level.
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Forecasting

Forecasting costs to complete for item based projects, allows both forecasting by individual
item, and forecasting by Cost Centres.

As a project budget is loaded into Jobpac, either from an upload from Expert Estimation, or
manually, the detail of the budget of resources that are entered is transferred automatically to
both the forecasting worksheet by Item and the forecasting worksheet by cost centre. The
entered budgets and rates become the starting point for preparing a forecast. Each month a
forecast is prepared for each Schedule Item and cost centre, and is locked in. This forecast
becomes the starting point for next month’s forecast.

Generally the forecast final quantities, and the quantities done for Schedule Items and sub
items have been done prior to the detailed forecasting. The focus on forecasting is on the rates.

Any guantities to go that are changed in the worksheets will also change the forecast final
gquantities for associated sub items. This will change the earned budget for that cost centre and
Schedule Item.

Forecasting by Item

Each Schedule Item in the schedule should be reviewed each month to establish if rates need
to be changed, or new forecasting items are required to accurately forecast the cost to
complete.

To update Forecast by Item from the Jobpac main menu, select Project>Job Setup and
Reports>Schedule of Rates>SOR Job Forecasting>Forecasting By Item

Enter the Job number or use the Job search function to search for the required job then click
OK. The following screen is displayed.

Project Manager Worksheet Forecasting by Item & actions @ ok BACK
Job SORPR2 SORPR2 Test
Section
QUANTITIES FCC RATE BUDGET RATE AUDIT TAGS VARIATIONS
¥ Hide  Apply > e
Position - Section fo) FCC Rate Override Used (YiNg) Period  maR22
o
Item Description Unit Current Quantity Forecast Final Oty Done Quantity Quantity To Go Claimed Quantit &
1 Preliminary & General |
Test A
11 Safety, Environmental and LS 1.0000 1.0000 1.0000
32 Public Pipe Supply and
TESTE
3.2B Catchment B
B3.2.8a 300mm dia. pipe m 50.0000 50.0000 50.0000
(3.2.2a 375mm dia. pipe m 70.0000 70.0000 70.0000

Project Managers Worksheet Forecasting by Iltem
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All of the fields on this screen are changed from other places. This represents a summary after
all the previous quantity changes that have been done. The Section filter allows the user to just
display a particular section.

A rate override facility is available at the Schedule Item level. This is described in the next
section. The filter at the bottom of the screen enables the user to just display those Schedule
Items where this feature has been used.

A number of tabs are available to display other data associated with the Schedule Items.

The tab Budget Rate shows the Original and current budget rates for each item, and also the
Forecast Cost to Complete Rate (FCC Rate).

The FCC Rate for a Schedule Item is calculated by subtracting the Budget Earned to Date from
the Forecast Final Cost for the Item divided by the quantity to go for the item.

The Audit tab shows the last person and date who changed the forecast by using PMW by item
or PMW by cost centre, and also the last person to change the forecast via changing quantities
in the Earned Budget or Forecast Final Quantity functions.

The Variations Tab shown only those items that are linked to variations.

When a Schedule Item is selected, all of the sub items (resources) required to complete that
component of work are displayed.

Project Manager Worksheet Forecasting by Item & actions @ ok BACK

Job SORPR2 SORPR2 Test
Seq# 12 Original Oty 50.0000 Sell Rate 400.0000
Section 20 Contract Oty 50.0000 Claimed To Claim 50.0000
Item B3.2.8a 300mm dia. pipe FFQ 50.0000 Orig Rate 278.0000
FM sC Schedule Item ¢ Oty Done Curr Rate 278.0000 Budg to Comp 13,900.00

FaC 50.0000 FCC Rate 278.0000 m FCC 13,900.00

O Rate Override Used

FORECAST NOTES AUDIT

Y Hide Apply  Clear B @ € > e
Period  maR22 Notes Worksheet Lines
Line Resource Description Unit Production Rate Qty To Go Rate Amount Cost Code T PC B
1 300PVC m 1.0000 50.0000 50.0000 2,500.00 50&0 MT P
2 GAP20(PERT) ton 1.2000 60.0000 30.0000 1,800.00 50s0 MT P
3 GAP20(PERT) ton 1.2000 60.0000 30.0000 1,800.00 N
& TRANSPORT - GAP 20 (PER T) ton 1.2000 60.0000 10.0000 600,00 5040 PL P
5 DRAINLAYER HOUR 2.0000 100.0000 50.0000 5,000.00 50&0 LB P
G OPERATOR HOUR 2.0000 100.0000 40.0000 4£,000.00 5050 LB P
7 P
8 P

The top section of the screen displays the current status of this Schedule Item
The Original Qty is that at the time of budget finalisation

The Current Qty is the current contract quantity.

The FFQ is that entered in the Forecast Final Quantity screen.

FQC is the Forecast Quantity to complete (FFQ — Quantity Done)
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FCC Rate is the overall Rate to complete for the whole Schedule Item. This can be used in
conjunction with the Rate Override Used indicator. This is described in the next section.

FCC is the Forecast Cost to Complete

Field

Line

Notes

Resource
Description

Unit
Qty to Go

Rate

Cost Code
CT
P/C

Description

Line number. This is the link back to the originating sub item in the
budget for the Schedule Item

Notes that describe how the estimate or forecast was generated. These
are copied from the budget when the budget was created. New forecast
lines can be created in the Forecasting worksheet. This will
automatically create an equivalent budget line for the Schedule Item,
with a budget quantity of zero.

Name of the resource required for this element of work.

Unit of Measure

If Earned Budget has been done for the project, this quantity should
reflect the quantity required to complete this element of work. If it is
change here, it will result in the FFQ for the element of work to be
adjusted (FFQ = Qty Done + Qty to Complete)

Rate to complete. (next version of this document will include Resource
Library facility)

Cost Code for this element of work.
CostType.e.g. L, M, P, S

Pending or Contingency. Pending is the default. Lines can be marked a
contingency components of the forecast. Jobpac will sum those lines
marked C, and will present the total value of contingency in the Project
Summary Report. These can be changed at any time.

This field can also be ‘R’. This is used to indicate the line item is related
to Rates Only Schedule Items, or Schedule Items linked to Quote
Variations. No forecast can be done for these lines, and they do not
contribute to the FCC for the cost centres associated with them.

Comment indicator.
Y’ — Comment line;

‘N’ — Forecast line.

Each line has a number of options associated with it. These are displayed using the Right

Mouse Button.

Cut
Copy

Extended Notes
Extended Resource Description
Delete

Cut to Another ltem
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Paste before
Paste after
Prompt

Copy to Another Item

These allow the changing of the detailed descriptions of the line item, deleting of the line, and a
range of Cut and Copy options for sub items. To Paste a line, select where you want to insert
the line, and use Paste Before(the line) or Paste After(the line). Prompt is cursor sensitive.

Actions Options

Expand/Contract

Prompt

Add

Next Tab

Budget Makeup

Build From Sub items

Build From History

Delete All

FFQ entry

Cost Centre Enquiry

Next Iltem

Previous Item

Description

Expands the description to show all lines of the description,
and contracts back to one line.

Cursor sensitive. System will display a popup list related to the
data where the cursor is positioned.

Positions the cursor at the next available position to enter a
new line.

Each click of this will take user to next tab.

This displays the makeup of the cost centre budget associated
with the Schedule Item. The current budget is displayed, and
the option to show the original budget is available in that
display.

This will replace the current forecast with the current budget or
original budget (user selects) for that Schedule Item. A preview
is provided. To actually make the replacement, select Build
From Sub items from the preview screen.

This will replace the current forecast with that of a nominated
previous month. A preview is provided. To actually make the
replacement, select Build From Sub items from the preview
screen.

This will completely delete all lines in the worksheet for the
Schedule Item.

Displays the FFQ screen and allows the FFQ for the Schedule
Item to be changed.

This is cursor sensitive. The full budget of the cost centre is
displayed. All Schedule Items that makeup the cost centre
budget are displayed.

Allows user to move forward to next Schedule ltem without
returning to Schedule Item screen.

Allows user to move backward to previous Schedule Item
without returning to Schedule Item screen.
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Forecasting Rate to Complete

Forecasting every resource within every Schedule Item may not be appropriate or time
effective. There is a facility to nominate a rate to complete for the Schedule Item, and have this
rate used to change each resource rate proportionally. For example,

If current Rate to complete for the Schedule Item is $278 per unit. (QTC/FFC for item)
And Proposed Rate to complete is $250 per unit, then the rates for each resource within
the Schedule Item are reduced by 250/278, with corresponding changes to the FCC.

To use this facility, tick the box “Rate Override Used” Parameter PMWIRO can turn this on.

Selecting OK will change the rates as shown in the screen below.

Project Manager Worksheet Forecasting by ltem ° ACTIONS O oK BACK
Job SORPR2 SORPR2 Test
Seq# 12 Original Oty 50.0000 Sell Rate 400.0000
Section 20 Contract Oty 50.0000 Claimed To Claim 50.0000
Item B3.2.8a 300mm dia. pipe FFQ 50.0000 Orig Rate 278.0000
M SC Schedule ltem ¢ Oty Done Curr Rate 278.0000 Budg to Comp 12,900.00

FQC 50,0000 FCC Rate 250.0000 m FCC 12,500.00

Rate Override Used

FORECAST NOTES AUDIT

Y dide  Apply  Clear E ﬂ £ h LT
Period  maR22 Notes Worksheet Lines
Line Resource Description Unit Production Rate Qty To Go Rate Amount Cost Code T PC B
1 300PVC m 1.0000 50.0000 44,9640 2,268.20 5040 MT P
2 GAP20(PERT) ton 1.2000 60.0000 1,618.71 5040 MT B
3 GAP20(PERT) ton 1.2000 60.0000 1,800.00 N
& TRANSPORT - GAP 20 (PER T) ton 1.2000 60.0000 539.57 5040 PL P
5 DRAINLAYER HOUR 2.0000 100.0000 4,596.40 5040 LB P
[ | OPERATOR HOUR 2.0000 100.0000 35.9712 3,59702 5040 LB P

The rates have been changed, and this is indicated by the colour of the rate. This colour will
also display in the forecasting Worksheet by Cost Centre for these resources.

The Forecasting by Item summary screen has a filter at the bottom of the screen that enables
the user to just display those Schedule Items where this feature has been used.

This indicator also appears on the Forecasting worksheet by Item report and the Cost
Comparison and Forecast Report.

Forecasting by Cost Centre

Once forecasting of quantities has been done, and Forecasting by Item has been used to
assess and change rates to complete, the forecasting status of each cost centre can be used to
refine the forecast. This is done via the BFM Contract Valuation Maintenance screen. The
function may be available via a separate menu function while not in a review period. Once in a
BFM review period, it is only available via the BFM Contract Valuation Maintenance screen.

Either options take the user to the same initial forecasting screen shown below.
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The standard PMW Forecasting manual describes the many features in the forecasting
worksheet. This manual will focus on the functions that have been added through the Schedule
of Rates features.

Cost Centre Cost Reconciliation & actions @ ok BACK
Asat  MAR22

Job SORPR2 O M 4 » M SORPRZTest

O Lock Job
GAIN/LOSS W/S ENTRY BY C/C COMMITTED EARNED VALUES MOVEMENT GAIN/LOSS MOVEMENT AUDIT ACCRUALS FORECAST
Y dide  Apply * s > e

Cost Code T Description PMW Entries FCC Difference Gain/Loss Last Sts =

Update

2050 Underground Services A

2050 LB Underground Services 4900.00 4900.00 A

2050 Mt Underground Services 4,800.00 4,800.00 A

5040 Testing of Pipework 25/04/2022 A

5040 LB Testing of Pipework 8,093.52 8,093.52 906.48  25/04/2022 A

5040 MT Testing of Pipework 3,866.91 3,866.91 433.09  25/04/2022 A

5040 PL Testing of Pipework 539.57 539.57 60.43  25/04/2022 A

6020 Traffic Management A

6020 LB Traffic Management 12,750.00 12,750.00 A

6020 MT Traffic Management 8,600.00 8,600.00 A

6020 PL Traffic Management 1,000.00 1,000.00 A

9996 Preliminary Parameters A

The Last Update column is the date the last user updated the forecast for that cost centre.

The Forecasting worksheets are displayed for the selected cost centre by choosing either the
PMW by Cost Centre or the PMW By Cost Code. The PMW By Cost code displays all

worksheet entries for all cost types for the cost code.
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PMW Forecasting by Cost Code & actions @ ok BACK
Job SORPRZ M 4 b M SORPR2Test NEW FCC = Sum of Worksheet Entries Formula H
Cost Code 6020 4 p Traffic Management NEW FFC = Cost of WIP + FCC Last Upd Date
Last Upd User
Current Budget 22,340.00 JAN22 PF FEB22 PF MAR22 PF Worksheet
Cost OFf WIP 0.00 0.00 0.00
RC.C. 0.00 0.00 22,340.00 1.00 22,340.00
FELC 0.00 0.00 22,340.00 1.00 22,340.00
Gain/Loss 0.00 0.00 0.00 0.00
Movement 0.00 0.00 0.00 0.00
WORKSHEET HEAD CONTRACT ITEM SEQUENCE NUMBER AUDIT TEM DESCRIPTION NOTES
Y Hide  Apply E < > eee
Showasat  MaRZZ [ 2 |
T Line Resource Description Quantity Units Rate Value C/P A R ™ B
LB | 4 DRAINLAYER 14£0.0000 HOUR 51.0000 71000 P N ¥
LB 5 OPERATOR 14£0.0000 HOUR 40,0000 560000 P N ¥
MT 1 375PVC 70.0000 m 80.0000 560000 P N ¥
MT 2 GAPZ0(PERT) 100.0000 ton 30.0000 3,00000 P N ¥
PL 3 TRANSPORT - GAP 20 (PER T) 100.0000 ton 10.0000 1,00000 P N ¥
Key elements on this screen are:
Last Upd Date Last time any of the FCC for the cost centres for this cost code
were changed.
Head Contract Item Tab  This displays the Schedule Items to which each resource line is
attached.
Audit tab Selecting this tab displays the following screen.
PMW Forecasting by Cost Code & actions @& ok BACK
Job SORPR2 M 4 P M SORPR2Test NEW FCC = Sum of Worksheet Entries Formula H
Cost Code 6020 4 p Traffic Management MEW FFC = Cost of WIP + FCC Last Upd Date
Last Upd User
Current Budget 22,340.00 JANZ22 PF FEB22 PF MAR22 PF Worksheet
Cost OF WIP 0.00 0.00 0.00
FCC. 0.00 0.00 234000 100 22,340.00
FEC. 0.00 0.00 236000 100 22,340.00
Gain/Loss 0.00 0.00 0.00 0.00
Movement 0.00 0.00 0.00 0.00
WORKSHEET HEAD CONTRACT ITEM SEQUENCE NUMBER AUDIT TEM DESCRIPTION NOTES
Y Hide Apply E £ > eee
Showasat  MARZZ b M
T Line Resource Description Unit A R Lst PMW Upd Lst PMW  Lst PMW Upd Lst EVB Upd Lst EVB Lst EVBE Upd T =
D Date  Upd Time User Date  Upd Time User T
LB | 4  DRAINLAYER HOUR P M Y
LB 5 OPERATOR HOUR P M Y
MmT 1 373 PVC m P N Y
MT 2 GAP20(PERT) ton p NoY
PL 3 TRANSPORT - GAP 20 (... ton P N Y I
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The FCC for the cost centre will change during the month due to commitments being actioned,
e.g. purchase orders, invoices, payroll, etc. When any changes are made to the pending lines,
either by earned value quantities being entered, or a remeasure of the Schedule Items, the FCC
for the cost centre is automatically updated by the sum of the worksheet entries.

The Last PMW Update Displays the last date/time a user updated the forecast for the cost
code via either of the forecasting worksheets.
The Last EVB Update Displays the last date/time a user updated the forecast for the cost
code via either the Forecast Final Quantity or the Earned Value options.

P?:1 L] .
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Combined Upload for FFQ, QTY Done, and
Claimed Quantities

There is a single upload available for:

e Forecast Final Quantity
e Quantity done
e Quantity claimed.

This is available in multiple places throughout the SOR Options

Forecast Final Quantity Entry

Forecast Final Quantity Entry & actions | @ ok BACK
Expand/Contract
Job SORRSL SOR Resource Library Project
Prompt
Contract Sum
Clear Filters
Current Claim Amount
Full Description
Current Earned Budget
FFO & Qty To Go
SHOW CLAIMED FORECAST FULL DESCRIPTION SEQUENCE NO TAGS VARIATIONS Oty Done to Claim
Y side Apply Claim to Oty Done P
Next Tab
Period  MaRZ2
e Download
o o o | Upload
Item Code Description Cmp Unit FM  ParChd Claimed Qty F'cast Final Qty Qty Done Feast Oty To G2
1 Preliminary & General
Test A
11 Safety, Environmental and N LS LS 1.0000 1.0000
Enter Quantities Done
Calculate Earned Budget for ltems & actions | & ok BACK
Detail/Summary
Jab SORRSL SOR Resource Library Project
Refresh
Current Budget EB This Period EB To Date CWIP To Date Variance To Daty Clear filters
Project Totals 45,940.00 Next Tab
Filtered Totals 45,040.00 Claimed to Qty Done
Prompt
QUANTITY DONE DESCRIPTION SEQUENCE NO AUDIT VARIATIONS
— Expand/Contract
Y Hide  Apply Download ]
Upload
o) o o p ’
For Period  MAR22
Item Description Contract Quantity B/  Unit Tp FM Pc Forecast Final Quantity Done % Comp  Upd
F Quantity Sis 7
1 Preliminary & General B M Y
Test A B cm ¥
11 Safety, Environmental and 1.0000 B LS LS 1.0000 ¥
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Progress Claim Entry

Progress Claim Entry | & Actions | @& ok BACK
Next Tab
Job  SORRSL SOR Resource Library Project Claim Number 1 Date
Expand
QUANTITY ENTRY DESCRIPTION CLAIM VALUES UNDER/OVER CLAIM AUDIT VARIATIONS TAGS Prompt NTRY
Current Contract Amount 60,000.00 This Claim Amount Claim to Date Amount Refresh
Y Hide  Apply  Clear Clear Filters Y eee
Report Print
o o o - )
— Variation Section
Include Previously Claimed at 100%
Copy Oty Done
Item Description Head FM  Par Unit Curr Contract Oty Qty Done Show/ Hide Child To Date Ot
1 Preliminary & General H cm Download
Test A h m Upload
11 Safety, Environmental and LS LS 1.0000
32 Public Pipe Supply and H cm

The same template is used for all three uploads. It can be used to upload all three Quantities, or

just one or two.

It is always preceded by a download. The Columns
uploaded.
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Resource Library

Introduction

A centralised resource library option is available for SOR Projects. The library can either be
generated from Expert Estimate upload, manually created or ‘built’ for existing live projects. The
review and bulk application of new forecast cost rates across a project is also supported with
audit trails.

This library is based on standard Description or Resource names used for each Subitem line in
the Schedule of Rates.

For Example

SOR Item

R1.2 Construction of Footpath 400 M2 at $100/M2 = $40,000

Resources 1. Standard Labourer 200 HRS @ $50 = $10,000
2. Standard Supervision 50 HRS @ $70 = $ 3,500
3. 1.2 M Grader 50 HRS @ $100 = $ 5,000
4. 10mm Gravel 400 M2 @ $10 = $ 4,000
5. Thumper 100 HRS @ $100 = $10,000

Each of the descriptions of the resources are in effect ‘a Code’. They will appear many times in
other SOR Items. They must be consistently named.

A library of Rates is built up based on these names.

This library can then be used to update forecast rates for these Resources across the whole
project. E.g. If the rate for a 1.2M Grader moves to $120 per hour, then this new rate can be
pushed out to all the occurrences of 1.2M Grader throughout the project.

It is important to note these are forecast rates only, and the budget rates are not changed.

Setup for Resource Library

If a SOR Project is to use a Resource Library then the box must be ticked in Job Maintenance

[ Use Resource Code Cost Tracking? [ Disable Excel In Progress Claim Terms & Conditions Format
Use Resource Library Forecast Control

O This is a template job Template Job Number SORTMP D SOR Template

& Trimble. Construction
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This will cause the column description on Sub Items to change from Resource Description to

Resource Name.

When the SOR Project is loaded, and the Use Resource Library Forecast Control’

is ticked, a

Resource library is automatically created.

Resource Library Maintenance & actions @& ok BACK
Job Number SORRSL SOR Resource Library Project
Budget Finalised N
O ¥ Upload
PROJECTQTY  MOVEMENT RESOURCE DESCRIPTION
rent RL ¢ ( £5940,00 P ed RL Cor £5940.00
Y Hide  Apply Clear E < > see
o o
fol
Resource Name T Project Qty  Unit Current FCC Rate Current Resource FCC Proposed FCC Rate Proposed Resourc =
FC~
DRAINLAYER LB 242.8000 HOUR 50.0000 12,140.00 12,140.00
GAP 20 (PERT) MT 160.0000 TON 30.0000 £,800.00 30.0000 £,800.00
OPERATOR LB 240.0000 HOUR 40,0000 9,600.00 40,0000 9,600.00
PL INSURANCE MT 1.0000 ITEM 2,000.0000 2,000.00 2,000.0000 2,000.00
SAFETY REPORT MT 40000 NO 700.0000 2,800.00 700.0000 2,800.00
STANDARD FOREMAN LB 3.0000 DAY 600.0000 1,800.00 600.0000 1,800.00
STANDARD PM LB 3.0000 DAY 600.0000 1,800.00 600.0000 1,800.00
STANDARD Q5 LB 2.0000 DAY 650.0000 1,300.00 650.0000 1,300.00
TRANSPORT - GAP 20 (PER T) PL 160.0000 TON 10.0000 1,600.00 10.0000 1,600.00
300 PVC MT 50.0000 M 50.0000 2,500.00 50.0000 2,500.00
375 PVC MT 70,0000 M 80.0000 5,600.00 80.0000 5,600.00
Column Name Description

Resource Name

Cost Type

Project Qty
Current FCC Rate

Current Resource FCC
Proposed FCC Rate

Proposed Resource
FCC

There is one entry here for every resource that has appeared across the
project.

This is the cost type of the Resource. This must be consistent throughout the
project.

This is the total Qty of that resource across the whole project

This forecast rate is current used through the whole project for this resource

Project Qty * Current FCC Rate
This field in Changeable. The FCC rate can be change here.

Project Qty * Proposed FCC Rate

Right Mouse Click options
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Option
Audit History
UOM Change

Rate Change

Name Change

Delete

Action Menu options
Option

Add

Copy
Merge

Apply Rates All

Rebuild

Resource listing

Description

This show an audit of changes done to that Resource Name

The UOM for the Resource Name can be changed throughout the project.
This option presents a screen to nominate the new UOM, and to change it.

This actually applies the Change that was made for this Resource Name.

This can be used to change the name of the Resource throughout the
project

This can only be used if the Resource Name no longer is used in any PMW
entry.

Description

New resource Names can be added here, and then used in new subitems in
Forecasting by Item.

Resource Names can be copied from one project to another

Two or more Resource Name can be merged together, providing they have
the same Cost type, UOM, and FCC Rate

This will apply any outstanding Rate changes for all Resource Name

This can be used to Rebuild the whole Resource library

This prints out a list of Resource Names.

Adding a Resource Name from Forecasting By Item

If a new Subitem is added in Forecasting by Item, and the Resource Name does not exist, it can
be added to the Resource Library

In screen below, the line called Contingency was added.
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Project Manager Worksheet Forecasting by Item & actions @& ok BACK
Job SORRSL SOR Resource Library Project
Seqg# 12 Original Oty 50.0000 Sell Rate &£00.0000
Section 20 Contract Oty 50.0000 Claimed To Claim 50.0000
Item B3.2.8a 300mm dia. pipe FFQ 50,0000  Orig Rate 278.0000
FM sC Schedule ltem ¢ Oty Done Curr Rate 278.0000 Budg to Comp 13,900.00
FQC 50,0000 FCC Rate 2980000 m FCC 14,900.00
[0 Rate Override Used
FORECAST NOTES AUDIT
¥ Hide  Apply Clear E 9 < > e
Period  maR22 Notes Worksheet Lines
fo] fo]
o
Line Resource Name Unit Production Rate Qty To Go Rate Amount Cost Code T PC B
1 300 RVC M 1.0000 50.0000 50.0000 2,500,00 CV1s0 MT P
2 GAPZ0(PERT) TON 1.2000 60.0000 30.0000 1,800.00 CVis0 MT P
3 TRANSPORT - GAP 20 (PER T) TON 1.2000 60.0000 10.0000 600.00 CVis0 PL P
& DRAINLAYER HOUR 2.0000 100.0000 60.0000 6,000.00 CV1s0 LB P
5 OPERATOR HOUR 2.0000 100.0000 40.0000 £,000.00 CVis0 LB P
(T Co gencyl ITEM 5,000.0000 1.0000 5,000.00 CV1&0 MT P
7 P

When Ok is selected, the following screen is displayed, as this Resource Name does not exist.

Project Manager Worksheet Forecasting by Item & actions @& ok BACK
Job SORRSL SOR Resource Library Project
Seqg# 12 Original Oty 50.0000 Sell Rate &£00.0000
Scan Resource Name/Description ®
Job SORRSL SOR Resource Library Project
T Apply ©Q < > o
Contingency D
1 fo)
Resource Name Resource Description T uom Current FCC Current  Last Update Last Updat
Rate Resource FCC  User Dat ™

(No resource desc to display)

By selecting the Add option, this can be added to the resource library.
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Add New Resource

Job Number

Resource Name
Resource Description
Cost Type

el

Current FCC Rate

SORRSL

CONTINGENCY

S0R Resource Library Project

General Contingency

o]

MT

Item

1,00

v OK ‘ ¥ close ‘

This now appears in the Resource library, and can be used elsewhere

Budget Finalised N

PROJECT QTY MOVEMENT

Y Hide  Apply  Clear

Resource Library Maintenance

Job Number SORRSL SOR Resource Library Project

RESOURCE DESCRIPTION

Current RL Control DJC 53200.00

& ACTIONS

& ok BACK

? Upload

ORI TP

4 Annn

e

A Ann Annn

A Ann AR

| o

Resource Name T Project Qty  Unit Current FCC Rate  Current Resource FCC Proposed FCC Rate Proposed Resourc =
FC™

CONTINGENCY Mt 5,000.0000  Item 1.0000 5,000.00 1.0000 5,000.00

DRAINLAYER LB 240.0000 HOUR 60.0000 14,400.00 60.0000 14,400.00

GAP 20 (PERT) Mt 160.0000 TON 30.0000 4,800.00 30.0000 4,800.00

OPERATOR LB 240.0000 HOUR 40.0000 9,600.00 40.0000 9,600.00

A Ann Annn

A Ann AR
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Progress Claims

Head contract Progress claims are prepared by entering quantities claimed against each
Schedule Item where work has been undertaken. When the Claim is prepared, it is transferred
to the Accounts Receivable function, where it can be accrued, and then marked as certified.
Variations are claimed by establishing quantities claimed for each Schedule Item linked to a
variation.

To update the Progress Claim from the Jobpac main menu, select

Projects>Job Setup and Reports>Schedule of Rates>SOR Progress Claim>SOR Progress
Claim Entry.

Creating a Progress Claim

Select a Job number, and the following screen is displayed.

Progress Claim Entry m & actions @& ok BACK
Job  SORPRZ SORPR2 Test Claim Number 1 Date  26/04/2022
QUANTITY ENTRY DESCRIPTION CLAIM VALUES UNDER/OVER CLAIM AUDIT VARIATIONS TAGS AMOUNT ENTRY % ENTRY
Current Contract Amount 60,000.00 This Claim Amount Claim to Date Amount
Y Hide  Apply Clear ? E < > ees
o o o
Include Previously Claimed at 100%
Item Description Head FM  Par Unit Curr Contract Qty Qty Done Prev Claim Qty Claim To Date Ot
1 Preliminary & General H M
Test A h cm
11 Safety, Environmental and LS LS 1.0000
32 Public Pipe Supply and H cm
TESTE h cm
328 Catchment B cm
B3.2.8a 300mm dia. pipe SC m 50.0000
(3.2.2a 375mm dia. pipe SC m 70.0000

Claimed to Date quantities are entered in the last column. If quantities done have been entered
in the Earned Value function, then these can be copied to the claimed quantities. This can be
done individually or all quantities done can be copied over, or the Schedule Items can be filtered
on the screen and only the filtered Schedule Items copied over.

Quantities cannot be entered for Parent items, as these are calculated as quantities are entered
for the child items. There is a hidden rounding item for each parent to ensure that quantity done
* rate at the parent level exactly equals the amount claimed for the parent.

Example: If the sum of the amounts claimed for the children = $1,235,784.79, and the rate for
the parent was $176.89, then the system would calculate the

Quantity done to be $1,235,784.79 / $176.89 = 6986.1766635
Multiplying this back, with 4 decimal places 6,987.1767 * $176.89 = $1,235,784.80
The difference of 0.01 is held in the rounding item.
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Options for Right Mouse Click are:

Sub Items

To edit/view the item’s resource names, select the required row, right-click and choose Sub
ltems.

Copy Qty Done

To update the item’s Claim to Date Quantity with the item’s Quantity Done just for that SOR
Item, select the required row, right-click and choose Copy Qty Done.

Text
This show the Full Description of the SOR Item
Comments

Comments can be added to display under each SOR Item in the Progress Claim Report

Progress Claim Entry Functions

Progress Claim Entry functions may be accessed using the Actions menu options.

Next Tab
Expand/Contract
Prompt

Refresh

Clear Filters
Report Print
Variation Section
Copy Qty Done
Show/Hide Child
Download
Upload

Report Print

Use this option to print the SOR Progress Claim report. A Selection Screen is displayed.

[
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SOR Progress Claim Report & actions @ ok BACK
Jab EEEE £ SORPR2 Test

Claim 1 o]

Claim Date 26/04/2022

Period Work Done MARZ2

GST Code : 51 D GST Taxable Supply

Report Level O Section level (O Major Heading (H) Level (O Minor Heading (h) level @ Item Detail level

Include Heading/Subtotal [ Section level

O summary page
Detail

O Print Child ltems

[ Print Claimed Items Only

O Print Variation Summary Only

O Ready for Posting

Print Client Name on Progress Claim

Report Option ® FPDF O Excel

View the report

Include subtotal Major Heading (H) level
Minar Heading (h) level
Report Type O Headerpage [ Include footer

Print All Approved & Claimed Unapproved Variations

O Include footer

O Include footer

Field Name
Job Number

Claim Number

Claim Date

Period Work Done

GST Code

Report Level —
Section, Major
Heading (H), Minor
Heading (h), Item
Detail

Include
Heading/Subtotal

Include Subtotal

Report Type
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Description
Defaults to current job.

Defaults to current claim number. To print a previous Progress Claim,
use the menu option

Defaults to today’s date, and can be overridden.

This is the period in which the work was done. It is not the accounting
period of the actual claim. It is used as the key selection in the Claim
Certification Report.

Defaults to workid default output GST code

Defaults to Item Detail. This will show each Schedule Item on the
report. Three other summary options are available. These options
show one summary line for the Level option chosen.

If detail report level is selected, this determines if the Section heading
and subtotals appear on the report.

This determines if subtotals for major and minor heading appear on
the report. Defaults — Major Heading (H) level, Minor Heading (h)
level

Three reports types are available, Header page, Summary Page, and
the Details report. All can be produced as required. The additional
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Field Name

Print Child items

Print Claimed items
only

Print Claimed varns
only

Print Variation
Summary Only

Ready for posting

Copy Quantity Done

Description

option ‘Include Footer’ should be selected if a summary is to be
produced at the bottom of the report. This summary includes GST
and Retention.

Default is to not print child items. If they are printed only the quantities
claimed are displayed.

Default is to print all items.

Default is to print claimed variations only

This will print one line per variation on report.

If ticked this will establish an entry in accounts receivable. This entry
is not posted, or accrued. It also causes the report to be written to a
claim history table with the date created. Further running of the report
for the same claim number, with this option ticked will create
additional versions in the history table. Providing the AR entry has not
been accrued, then this entry will also be updated.

To copy the quantity done for all items into the Claim to Date Quantity, select Copy Qty Done
from the options on the Actions menu. A new window will be opened for you to confirm the
function to be done. Click Yes to proceed or No to cancel the copy function.

Confirm

9 Only filtered items will be copied.

Claimed CQuantity will be updated with Quantity Done,

‘ v Ves H ¥ no ‘

Show/Hide Child

To view/hide child values for the items, select Show/Hide Child from the options on the

Actions menu.

Downloading the Progress Claim

To download the progress claim into a spreadsheet, click on the Download button above the

table.
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Reprinting a Progress Claim
To reprint a Progress Claim, use option Reprint SOR Progress Claim

The standard Progress Claim Report selection options are presented, however there is an
additional option to select a prior Progress Claim. See screen below.

SOR Progress Claim Report

Job SORPRZ £ SORFR2 Test
Claim 1 D
Claim Version

Claim Version Sequence

Claim Date 26/04&/2022

If a scan is done on the claim no, a list of the previous claims is presented. You select from this

list.

Progress Claim Mumber Selection ®

Jab SORPR2 SORPR2 Test

T Apply € > em

_From | | Fry Fror - |

{la_\'!m Version Version Seq#  Period Clm For Claim Date Claimed Rolled Qver Created Date  Created Time UserId 2=3
Mo Version
Actions Options Description

Claim No Claim No as entered when claim raised

Version Automatically set to C

Version Sequ No This starts at 1 for each claim, and is incremented each
time the “Ready for Posting” is ticked. Normally only one,
but could be repeated.

Period Claimed For From the Progress Claim entry screen. Represents the
month the claim represents. This may be different to the
accounting period of the claim.

Claim Date Date as entered when claim raised.

Claim rolled Over This is set by rolling the claim over. This should represent
the certified values.

Created Date and time claim created.

P"ﬁ = &
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Actions Options Description

Userid Person who created the claim

Rolling Over a Progress Claim

Once certification has been received, the progress claim needs to be updated to reflect the
certified quantities, and variations. This should be done in Progress Claim entry. The claim can
then be rolled over. This simply has the effect of moving the current claimed quantities and
amounts to the previous fields. This is done by using the following menu option.

e oot & Trimble. Construction
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Importing a Variation Schedule.

This section will cover how to upload the Variation Schedule Item / Sub Item Structure from
Expert Estimation.

This upload uses the same Excel template as for the Contract Upload. However a different
menu option is used.

e Setup a variation section code and a variation preliminary section code. The variation
preliminary section is not required if variation preliminaries are not used. To setup
section code, refer to section, Setting up Section Codes.

e The variation section code and variation preliminary section code must be defined in the
Schedule of rates parameter. To setup the parameter, refer to section to Setting up
SOR parameter.

Loading an Estimate
To access Setup SOR Parameters from the Jobpac main menu, select

Projects>Job Setup and Reports>Schedule of Rates>/ SOR Job Setup>SOR Variation
Upload

If the Variation Preliminaries Spread option is being used, then these items must have a section
of 9000 in the upload spreadsheet. This section will be replaced by the one nominated in the
SOR parameter

Expert Estimation Variation Upload & actions @ ok BACK

Job for the upload file SORPR)] D
O Upload Variation Items to Project
O This is a Re-Upload

Start Seq No. (If blank, then Seq = Lastno + 1) o]

Evenly Spread Total OH Budget Across All Pay Items

Report Option ® PDF O Excel

View the report

Please enter cost centre for the following provisional subitems -

< >
Sect Item Code Line Description Unit Quantity Rate Amount Cost Code T =)
Variation Expert Estimation Upload
Complete the parameters as follows:
Field Description
Job No The Job must be schedule of rates job and a template job

has been associated to the job.
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Field

Upload Variation Item to
Project

This is a Re-Upload

Start Sequence Number

Evenly Spread Total OH
Budget across all Schedule
Iltems

Cost Centre

Report Option
View Report

Description

Set this to N if doing an initial load and want to check if all
lines are valid.

Set to Y when there are no invalid lines. By setting this
field Y, the load process will update Jobpac.

The process will allow multiple uploads of variation
Schedule Items. If a batch of variation Schedule Items that
have already been uploaded is to be replaced with a new
batch, then this option must be set to Y. Otherwise, it
should be set to N.

Nominate the start sequence number to insert the
Schedule Items to be uploaded. If a number is nominated,
system will check if total available numbers between the
nominated start number and next used sequence number
is more or equal to the total number of Schedule Items to
be uploaded. If there is not enough available numbers,
system will display an error message. If not nominated,
then start sequence number will be the last number used
plus 1.

Set this to Y if total OH budget is to be evenly spread
across all items. Total OH budget is the total Schedule
Items overhead defined in the csv file. The variation prelim
contribution % will be calculated as total OH budget
divided by total direct costs. The calculated % will then be
used to calculate Item Prelim OH by multiplying the % by
the item total direct cost.

Set this to N if overhead is not be evenly spread across alll
items. The item overhead is the value defined in the csv
field and variation prelim contribution % will be calculated
as item overhead divided by total item direct cost.

If the Overhead spread function is not used, this should by
N

The sub item lines shown on the screen are provisional
lines. Upload will identify all provisional items and sub
items with a “PS” in item type. User is allowed to input the
cost centre per provisional sub item. Cost centre, if
entered, must be a valid cost centre from the template job
or user can use the search function to select from the cost
centre scan window. Only used if Upload is direct from
Expert Estimation.

Select Spool file, PDF or Excel.

If you select this box, the report will be displayed on
screen prior to printing.

File can be re-uploaded if the following criteria have been met;

e Variation Schedule Items are not linked to variations
¢ No claims made against any of the item

¢ No quantity done

& Trimble. Construction
I




_ V¥ Viewpoint
Schedule of Rates Projects Jobpac Connect”

When re-uploading, it will display a screen of all variation Schedule Items.

The user must select all variation Schedule Items that will be replaced by the upload. The
upload will delete the selected variation Schedule Items, sub items, worksheet entries, notes
and descriptions including the “Original State” files prior to adding the new batch. If Schedule
Item to be replaced is a variation prelim item, then upload will write a reversal line of the prelim
overhead budget on the variation holding preliminary item.

Expert Upload Validation Report

A sample of the validation report produced by the upload program is embedded in this sheet.

<t aihe
Adobe Acrobat Adobe Acrobat
Document Document

The validation report will list all lines regardless line is valid or not.

Erroneous lines are flagged with starting error description of #ERR. If the uploaded item
contract value is not the same as the calculated value and the difference is within the allowable
variance defined in the system parameter EXTVAR, then a warning message will be printed. If
not within the allowable variance, then an error message will be displayed. Uploaded item
value is the sum of the direct cost, overhead cost and margin. Calculated item value is quantity
* rate.

When there is rounding difference between the parent and sum of the child items, upload will
create a rounding item where rounding item value will be set to the difference. The rounding
items will be printed at the end of the report.

A Bulk Resource List will also be printed if the project is using Resource names. The report will
list the following details

Resource Description
Notes

Resource Names
Unit of Measure
Quantity

Rate

Total Amount

Totals are printed at the last page of the report.
Total Overhead Budget (Schedule Item Level) is the total of the uploaded overhead

Nominated OH (Allocated OH) is the sum of the prelim section sub item lines. Prelim section
will be have section code = 9000.

Unallocated OH will be equal to the difference between Total Overhead Budget (Schedule Iltem
Level) and Nominated OH.

Contract Sum is total of the calculated item value (Qty * rate)
Direct Cost Budget is the total of the sub item lines budget

Overhead budget is equal to the overhead budget at Schedule Item level
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Total budget is the sum of direct cost budget & overhead budget

Margin is calculated as the difference between contract sum and total budget

Total number of records will be printed.

Total invalid records will also be printed.

When the file is uploaded Files will be automatically be copied to the “Original State” Files.

The Schedule Item sequence number will be generated by the system. The start sequence
number will be the number nominated on the upload screen. If not nominated, then the start
sequence number will be the last used sequence number plus. 1. The number will be
incremented by 1 for each of the succeeding Schedule Item.

The 9000 Trade/section code will be replaced by the variation preliminary section defined in the
SOR parameter

Trade/section code Schedule Items where trade/section code is not 9000, will be set to the
variation section defined on the SOR parameter.

Forecasting method of provisional items will be set to “RO”.

Parent code of parent item will be generated starting from AA, AB, AC, AD etc. The upload will
add the code to the parent code table.

Project contract sum, and margin will be not be updated. The overhead budget will be updated
but the impact on the total budget will be nil.

Establishing a Variation

If variations are to be used on a SOR project, then the Variation section MUST be setup in the
SOR Parameter, and the project budget must be finalised...

The starting point for establishing a head contract variation is the Variation register. A variation
is created in the register. It is given a number, a description, a date, and a status. Then the
option Variation Buildup is used to link variation Schedule Items to the variation. The contract
value of the Schedule Items is added to provide the Price for the variation. The Expected
revenue field in the variation register will be defaulted to the Price. The resources for these
Schedule Items combine to become the budget for the variation. Variation Schedule Items do
not contribute to the contract value or budget until the variation is transferred.

To create a variation, use Variation Register. Enter the job number, and enter a variation no, or
allow system to allocate the next number.

& Trimble. Construction
e e




Schedule of Rates Projects

W Viewpoint
Jobpac Connect”

Variation Register & actions @ ok BACK
Job M 4 SORFRO p M Schedule OF Rates Project
Variation Number 02 0001 Not Transferred To Jobcost Last Variation
Descriptian SOR Variation Description (o) Allocated 0.00
VariationStatus @ N O W O A O P OR O D L NotSubmit Date 26/04/2022 Unallocated 0.00
Client Reference Date Price
Site Reference Date Expected Revenue
Proceed/Quote @® Proceed (O Quote Type D Budget
Client VO Number Package Q Margin 0.00
Reason Q Ext. of Time Days
Edit Client Notification Text
Y dide  Apply  Clear £ >
o
o
Cost Code T Cost Centre Description Budget B
Field Description

Description (mandatory)

Status (mandatory)

Date (mandatory)

Client Reference
Date

Site Reference
Date

Proceed/Quote

Client VO Number

Edit Client Price
Submission Detail

Price

Expected Revenue

Budget

Full description of the variation. The triangle can be selected to display a
drop down text box where a full description can be entered.

Defaults to N Notified. Can be changed to required status.

Date associated with the status. If the status is changed, then the date can
be changed to match the status.

Document reference from the client (not mandatory)
Date of client reference

Document reference from project

Date of site reference.

Must be marked Proceed before a variation can be transferred, or any
forecasting can be done.

If marked Quote, then variation cannot be transferred, and cannot be
forecast. The details of resources can be viewed in the PMW by Item, but
cannot be changed.

The number the client has assigned to the variation. Optional

If status is W, Selecting the icon displays a screen where the price
submission can be prepared. See Price submission below.

If status is N, then this displays as Edit Client Notification Text.

Sum of the contract values of the linked Schedule Items. Cannot be
overridden.

Defaults to the Price, and can be overridden. It Is the value the project
contract is updated by if the variation is transferred before it is approved.

Sum of the budgets of all resources of linked Schedule Items.
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Field

Margin

Allocated

Unallocated

Actions options are

Option
Delete

Transfer

Prior status

Variation Buildup

Display Budget detail

Variation Buildup

Description

Difference between Price and Budget if variation is approved, and
difference between Expected Revenue and Budget if variation is
unapproved.

Represents the sum of the budgets of all resources of linked Schedule
Iltems.

Represents the difference between the total variation budget, and the sum
of budget for all resources.

Description

Whole variation can be deleted if not linked to any Schedule Items.

Used to update the contract value and budget of the project. Changes to
untransfer, after variation is transferred. No changes can be made to the
variation while in transferred status.

If data exists, e.g. values, dates for prior statuses, then these will be
displayed in a popup window.

This option displays all variation Schedule Items that are linked to the
variation, or if no Schedule Items are linked, displays all unlinked variations.
It is within this area that new variation Schedule Items can be added and
linked to the variation.

See Below

When Schedule Items are linked to a variation, the budget for the variation
is the sum of the budget for all the linked variation Schedule ltems
summarised at cost centre level. This option will display the details that
makes up the budget for the variation.

Selecting Variation Buildup displays the following screen.
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Variation ltem Maintenance & actions @ ok BACK
Job SORPRO Schedule Of Rates Project
Variation 20001 SOR Variation Description Direct Cost Budget 8,000.00 Budget Finalised Y
Section 8000 Variations Section
Overhead Budget 2,000.00 Contract Sum 10,000.00
*Unlinked
Allocated 1,600.00 Budget 10,000.00
Available £00.00 Margin
SCHEDULE SEQUENCE NO. DESCRIPTION BUDGET QUANTITIES MARGIN OVERHEAD TAGS
Y Hide  Apply < > o
Variation Status Not Subm Waiting App Approved Fartially App Rejected Withdrawn
| fo] fo] o
Period  MaR3? D
Item Description Hd Sell Price Current Budget Margin Varn  Varn Sts Varn Date  Van
Number T
Bl SOR Item 10,000.00 10,000.00

If no Variation Schedule Items are linked to the variation, then all unlinked Variation Schedule
Items are displayed. This is all unlinked Schedule Items in the variation section, nominated in

the SOR Parameter.

From this screen, Schedule Items can be linked to the variation, and new Schedule ltems can

be created in the variation section and linked to the variation.

Variation Item Maintenance & Actions @ ok BACK
Job SORPRO Schedule Of Rates Project
Variation 20001 SOR Variation Description Direct Cost Budget 8,000.00 Budget Finalised Y
Section 8000 Variations Section
Overhead Budget 2,000.00 Contract Sum 10,000.00
*Unlinked
Allocated 1,600.00 Budget 10,000.00
Available £00.00 Margin
SCHEDULE SEQUENCE NO. DESCRIPTION BUDGET QUANTITIES MARGIN OVERHEAD TAGS
¥ Hide  Apply P oo
Variation Status Not Subm Waiting App Approved Fartially App Rejected Withdrawn
o o o
Period  MaR3? D
Item Description Hd Sell Price Current Budget Margin Varn  Varn Sts Varn Date  Van
Number LI
B ISOR Item| 110,000.00 10,000.00

Select

Extended Description
Change Section/Item
Cut

Copy

Paste Before

Paste After

Delete

Variation

Lin

Unlink
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Applicable Actions options are

Option
Add New Item

Variation Section

Copy Single Item
Bulk Item Copy

Show/Hide Child
Spread O/H Budget

Description

New Schedule Items can be added only to the variation section

Displays a screen that summarises all values associated with the Schedule
Items in the Variation section (see below)

Allows copy of Schedule Item from the main schedule into the variation section

Allows copy of a range of Schedule Items from the main schedule to the
variation section.

NB. If a Parent item and all children are to be copied from the main schedule,
then the new Parent item must be setup first in the Variation section. The
children are copied from the main section and then linked to the parent.

This can be used to display or hide child items

If additional (or reduced overhead budget) has been produced by remeasures
of Schedule Items that contribute to overhead budget, this option can be used
to spread this budget to existing overheads. Selecting this option display the
value of main item schedule overheads available for spreading, and the value
of variation overhead budget available for overhead. Either of both can be
selected for spreading.

The right mouse options are the same as for Iltem Maintenance, but additional options are
displayed to Link or Unlink variation Schedule Items to the variation. The sum of the price of the
payitems, and the sum of the budgets for the variation Schedule Items that are linked to a
variation are used as the variation price, and the variation budget.

After the appropriate Variation Items are linked to the variation, the option BACK takes you back

to the Variation.

Variation Register & actions @ ok BACK
Job M 4 SORFRO p M Schedule OF Rates Project
Variation Number 02 0001 Not Transferred To Jobcost Last Variation 02 0001
Description SOR Variation Descriptior{ @ Allocated 10,000.00
VariationStatus @ N O W O A O P OR O D L NotSubmit Date 26/04/2022 Unallocated 0.00
Client Reference Date Price 10,000.00
Site Reference Date Expected Revenue 10,000.00
Proceed/Quote @ Proceed (O Quote Type o] Budget 10,000.00
Client VO Number Package Q Margin 0.00
Reason Q Ext. of Time Days
Edit Client Notification Text
Y dide  Apply  Clear £ >
o
o
Cost Code T Cost Centre Description Budget =
1002 MT Survey 8,000.00
9998 MT Var Prelims Holding 2,000.00
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Selecting Variation Section

If this is selected, the following screen is displayed.

Item Maintenance - Variations & actions @ ok BACK
Job SORPRO Schedule OF Rates Project Original Cont Value 10,000.00 Linked (Transferred)
Section No 800D Variations Section ) ) .
Quantity Changes Linked (Untransferred) 10,000.00
App Varns (Trans) Unlinked

Unapp Varns (Trans) (ER)

Current Contract Sum 10,000.00

HEAD CONTRACT ITEM VARIATION DESCRIPTION SEQUENCE NO

Y dide  Apply  Clear < > see
Variation Status Not Submitted Waiting Approval Approved Approved In Principle ] Rejected Withdrawn Period MARZ2
o o o o
o] Linked Unlinked [o) (YIN{)
Segh  Item Description H/h M Varng#  Unit Price Budget Margin  Sts T B
1001 B SOR Item sC 20001 M2 10,000.00 10,000.00 N N

Similar functions are available in this screen, i.e. add new items or copy items from main
schedule.

The table at the top of the screen summarises the Contract submission.

Option Description
Original Cont Value Sum of Contract Values of all Schedule Items in Main schedule
Quantity Changes Contract value of re-measures since budget finalization
App Varns (Trans) Total contract value of approved transferred variations

Unapp Varns (Trans) Total Expected Revenue of un-approved transferred variations
ER

Current Contract Sum Total of above four items

Linked (Transferred) Total contract Value of all Schedule Items linked to transferred

variations
Linked Total contract value of all Schedule Items linked to un-transferred
(Untransferred) variations
Unlinked Total value of all unlinked variation Schedule Items.

Variation Price Submission

The system provides the ability to prepare a price submission to the client. The template used to

Edit Client Price Submission Detai

prepare this is displayed by selecting the icon on the
variation screen.
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Options on this screen are

Option Description

Publish Schedule This option will import all the Schedule Items linked to the variation

Item Details into the screen
Clear All Details This will clear all details from the screen.
Use Item Totals This will set the Submitted Price on the Variation screen to the Total

price in the worksheet.

Publish Schedule Item Details

If this option is selected all the Schedule Items linked to the variation will be imported into the
screen.

There are options within this screen to add heading lines, or insert or copy lines. This
information is reproduced on the Price submission form available in Variation documents.
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Reports — Schedule of Rates

There are various reports available to assist in the management of Schedule of Rates jobs.
They are accessed using the following menu path:

Access Path — Schedule of Rates Reports Menu

Schedule of Rates List

This report prints the item rates for the selected job(s) by item. Report totals are printed for the
selected job and section.

[tem Details

This report prints the item details for the selected job(s) by item. The Resources (Subitems) for
each SOR Item are printed.

Cost Centre Details

This report prints by cost centre, each item and subitem linked to that cost Centre.

F/C Worksheet by Item

This report prints the subitem forecasting information for the selected job(s) by item.

Iltem Quantities
This report prints the contract, forecast and claimed quantities for the job and item number.

=
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Reports — Earned Budget

There are various reports available to assist in the management of Earned Budget within
Schedule of Rates jobs. They are accessed using the following menu path:

Earned Budget — Item

This report prints the budget, forecast final and earned quantities and rates for the job and
section. Budget and earned budget totals for the job and section are printed at the end of the
report.

oot & Trimble. Construction

Module Guide | Version: 1.1




